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Data Acquisition and Processing Report

NOAA Ship Ferdinand R. Hassler
Chief of Party: LCDR Matthew J. Jaskoski, NOAA

Year: 2016
Version: 1.1

Publish Date: 2017-04-20

A Equipment

A.1 Survey Vessels

A.1.1 NOAA Ship FERDINAND R. HASSLER

Name NOAA Ship FERDINAND R. HASSLER

Hull Number S250

Description
FERDINAND R. HASSLER is a Small Waterplane Area, Twin-Hull (SWATH)
 coastal mapping vessel.   

Utilization Survey

Dimensions

LOA 37.7 meters

Beam 18.5 meters

Max Draft 3.85 meters

Most Recent Full
Static Survey

Date 2009-11-04

Performed By
Raymond C. Impastato, Professional
Land Surveyor

Discussion

This survey was provided by the
shipbuilder, V.T. Halter Marine, and
performed in the shipyard prior to
delivery.

Most Recent Partial
Static Survey

Date 2012-06-12

Performed By Kevin Jordan, NGS

Discussion

This survey was performed after
the POS/MV antenna mounts were
reconfigured to newly fabricated
mounts and ties the POS antennae into
benchmarks on the 03 deck.
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Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Date 2013-04-07

Method Used
Optical level run while ship was out of
the water in drydock

Discussion

A level loop was run from the POS
antenna to each sensor mounted on the
ship's hull. In addition, measurements
were made to both IMU base plates
through the 7125 cable passage. The
resulting offsets from this survey were
used to verify and update Z offsets
between all sensors.

Most Recent Static
Draft Determination

Date 2011-07-12

Method Used
Calculation from design waterline and
measured offsets

Discussion

Assumed design waterline of 3.8 meters
and measured offsets to IMU were used
to determine static draft of the reference
point. The ship's draft is operationally
managed with daily ballast to achieve
a true waterline of 3.77 meters. Draft
uncertainty is estimated at 0.05 meters.
See Section C.2.1.1 for additional
discussion.

Most Recent
Dynamic Draft
Determination

Date 2016-02-21

Method Used
Ellipsoid referenced dynamic draft
measurement (ERDDM)

Discussion

Data were acquired with canards at zero
trim angle. During all survey operations,
the canards are set to zero trim angle.
Averages are being calculated from all
ERDDM tests since the installation of the
buoyancy appendages in 2013. This will
help filter out errors located in individual
tests.
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Figure 1: NOAA Ship FERDINAND R. HASSLER, Starboard View
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Figure 2: NOAA Ship FERDINAND R. HASSLER, Bow and Stern View
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A.1.2 FH Launch 2702

Name FH Launch 2702

Hull Number 2702

Description
25ft enclosed cabin survey launch made by North River, outfitted with jet drive
 propulsion and Yanmar diesel engine. 

Utilization Near shore shallow water hydrographic survey vessel.

Dimensions

LOA 7.62 meters

Beam 3.05 meters

Max Draft 0.76 meters
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Most Recent Full
Static Survey

Date 2015-06-16

Performed By Kevin Jordan, NGS

Discussion

The intention of this survey was to
accurately position the POS/MV IMU,
GPS Antennas, Sonar Equipment,
benchmarks, and reference marks located
on the 2702 Launch.

Most Recent Partial
Static Survey

Partial static survey was not performed.

Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2016-08-14

Method Used Bubble level and tape measure

Discussion

The waterline was measured using a
bubble level and tape measure to measure
the vertical distance from the benchmarks
to the waterline. The static draft was
calculated using those values.

Most Recent
Dynamic Draft
Determination

Date 2016-03-03

Method Used
Ellipsoid referenced dynamic draft
measurement (ERDDM)

Discussion

This was the first dynamic draft
measurement performed on Launch
2702. Dynamic draft measurements will
be performed on an annual basis and
averaged to aid in filtering outliers.
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Figure 3: Launch 2702 profiles
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A.2 Echo Sounding Equipment

A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000 V2 Bathymetry

Manufacturer Klein

Model 5000 V2 Bathymetry

Description
High-speed high-resolution towed side-scan sonar (SSS) system. This system is a
 beamforming acoustic imagery device with an operating frequency of 455 kHz and vertical
 beam width of 40°. The Klein 5000 V2 system consists of a 5250 V2 towfish and a 5105



2016 DAPR Version 1.1           NOAA Ship Ferdinand R. Hassler                

9

 V2 Transceiver Processing Unit (TPU). The towfish is towed via 3/8" armored coaxial
 cable connected to a DT marine electro-hydraulic winch (s/n 1271 302 OEHLW3R)
 equipped with a Klein slip ring model: (14103033, s/n 1802003). The towfish is fitted
 with a Klein K-wing depressor wing. The winch is controllable from the sonar operator's
 station. Cable out is measured with a 3PS cable counter integrated with a General Oceanics
 model 4042 sheave. The sheave is mounted on the A-frame and is the tow point for offsets
 measurements. Cable counter accuracy was verified on August 3, 2012 using a known
 length of line.

The SSS cable was re-terminated on July 27, 2012 and a new 12 meter cable mark for the
 docked and zero measurement was marked and verified on March 3, 2014.

A side scan calibration was conducted on March 8, 2016(Dn068) on a buoy block offshore of
 Duck, NC with towfish SN: 386. In this test a number of lines were run adjacent to known
 buoy block. The side scan positions are compared with the multibeam positions in the
 attached report. The 95% confidence interval of the positioning error is 10.0 meters. The
 calculated error in the report is within the positioning error threshold established in the 2014
 Field Procedures Manual. 

Serial
Numbers

Vessel Installed

On
S250

TPU s/n 777

Towfish s/n 386

Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters 20  centimeters 36  centimeters 61  centimeters

Min Range 38 meters 75 meters 150 meters 250 meters

Max Range  meters  meters  meters  meters

Across Track
Resolution

3.75 centimeters

Max Range
Scale

250 meters

Manufacturer
Calibrations

Vessel Installed

On
S250

Calibration

Date
2016-03-08
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Figure 4: Klien 5000 V2 configured for towing

A.2.2 Multibeam Echosounders

A.2.2.1 RESON 7125

Manufacturer RESON

Model 7125

Description

The RESON 7125 is a dual head, dual frequency system configured to work as
 a unit.  While the particulars of the port system are specified in this section and
 the starboard head in the following section, this description and following quality
 control address the two heads as an integrated system. 
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The port and starboard sonars are mounted in their respective hulls with a 4.5 degree
 outboard tilt.  The sonars can be operated independently, but are typically operated
 together as a dual-head system using frequency modulated (FM) pulses combined
 with center frequency separation to enable simultaneous pinging between the heads.
  When operated as a dual head system, the starboard system acts as the master and
 the port system the slave.  The range scale, ping rate, surface sound speed, and time
 varied gain (TVG) parameters are controlled by the master.  

Patch Tests -

Due to installation of two new receivers during the 2016 April-June drydock period, a
 new patch test for the Starboard 400kHz and 200kHz modes was conducted on July
 9, 2016 (Dn191) in the southern approaches of Rhode Island Sound.

Reference Surfaces -

In conjunction with the new patch test noted above, a reference surface for both Port
 and Starboard, in both 400kHz and 200kHz modes was conducted on July 11, 2016
 (Dn193) in the southern approaches of Rhode Island Sound. 

Serial Numbers

Vessel Installed On S250 same

Processor s/n 18210412051 same

Transceiver s/n 212036 same

Transducer s/n n/a n/a

Receiver s/n 0214074 same

Projector 1 s/n 2611093 same

Projector 2 s/n n/a n/a

Specifications

Frequency 400 kilohertz 200 kilohertz

Along Track 1.0 degrees Along Track 2 degrees
Beamwidth

Across Track 0.5 degrees Across Track 1 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

512
Number of
Beams

512

Max Swath Width 140 degrees 140 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

150 meters 
Manufacturer
Specified

400 meters 
Depth Rating

Ship Usage 100 meters Ship Usage 250 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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System Accuracy
Tests

Vessel Installed On S250 S250

Methods Reference surface comparison
Ellipsoidal Referenced Lead Line
and Water Line

Results

Reference surfaces were performed
in the vicinity of Rhode Island
Sound on July 9, 2016 (DN191).
The 7125 200kHz and 400kHz
sonars were operated in single
head FM and differenced with the
opposite side sonar of the same
frequency. The distribution of depth
differences, port minus starboard
400kHz for DN191 reference
surface. Depths from starboard are
on average -0.04 meters deeper
than depths from port system with a
standard deviation of -0.05 meters.

On March 5, 2014 a static lead
line comparison was performed
relative to the ellipsoid for the port
7125 system. Ellipsoid height was
obtained on a fixed mark ashore
using static GPS observations.
While the ship was pierside at Judd
Gregg Marine Research Complex,
a lead-line was lowered to the
sea floor in the port 7125 field
of view while logging sounding
data. Observed ellipsoid height
was transferred to the suspended
lead-line using differential leveling,
and the distance from the lead to
the mark measured with a steel
survey tape. Logged sonar data
was processed through CARIS
using standard ERS methods
to yield an ellipsoid referenced
measurement. Results of this test
show the sonar measured depth
to be 0.03 meters shallower than
the lead-line derived depths with
a propagated uncertainty of 0.03
meters. In addition to the ellipsoid
measurement, the lead-line was
marked at the waterline and the
distance from the lead to the mark
measured with a steel survey tape.
Logged sonar data was processed
through CARIS using a zero-tide
file to yield a waterline referenced
measurement. Sonar depths were
an average of 0.04 meters deeper
than lead-line derived depths with
a propagated error of 0.06 meters.
The uncertainty of the measurement
is dominated by the uncertainty
in reading ship draft marks. This
test was repeated for the starboard
7125 system. Results show the
sonar depth 0.01 meters deeper than
the lead-line derived depths with
a propagated uncertainty of 0.03
meters. For the waterline; sonar
measured depths were an average
of 0.15 meters shallower than the
lead-line derived depths with a
propagated error of 0.06 meters.
There is still uncertainty of the
measurement, mainly dominated by
the uncertainty in reading ship draft
marks.
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Snippets Sonar has snippets logging capability.

Figure 5: 7125 Housing flush-mounted on hull.

Figure 6: Location of the patch test and reference surface performed in Rhode Island Sound.

Figure 7: A difference surface showing the difference in the Port 400kHz and Stbd 400kHz systems.

Figure 8: Statistics derived from the difference surface between the Port 400kHz and Stbd 400kHz systems.

A.2.2.2 RESON 7125

Manufacturer RESON

Model 7125

Description
Starboard system of a dual head configuration.  For a description of this system and
 associated quality control tests, see entry for port 7125.  
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Serial Numbers

Vessel Installed On S250 same

Processor s/n 18215011048 same

Transceiver s/n 212035 same

Transducer s/n n/a n/a

Receiver s/n 1215068 same

Projector 1 s/n 1111236 same

Projector 2 s/n n/a n/a

Specifications

Frequency 400 kilohertz 200 kilohertz

Along Track 0.5 degrees Along Track 2 degrees
Beamwidth

Across Track 1 degrees Across Track 1 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

512
Number of
Beams

512

Max Swath Width 140 degrees 140 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

150 meters 
Manufacturer
Specified

400 meters 
Depth Rating

Ship Usage 100 meters Ship Usage 250 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

System accuracy test was not performed.

Snippets Sonar has snippets logging capability.

A.2.2.3 R2Sonic 2022

Manufacturer R2Sonic

Model 2022

Description

The Sonic MBES works on a user selectable frequency range of 200 kHz to 400
 kHz so it is adaptable to a wide range of survey depths and conditions. The user can
 adjust the operating frequency, via the Sonic Control GUI, on the fly, without having
 to shut down the sonar system or change hardware or halt recording data. The Sonic
 MBES have a user selectable sector angle, from 10° to 160°, using all 256 beams;
 the desired sector angle can be selected on the fly without a halt to data recording.
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 The selected swath angle can also be rotated port or starboard, whilst recording, to
 direct the highly concentrated beams towards the desired target.  

Serial Numbers

Vessel Installed On 2702

Processor s/n 103297

Transceiver s/n N/A

Transducer s/n 800148

Receiver s/n N/A

Projector 1 s/n N/A

Projector 2 s/n N/A

Specifications

Frequency 200 kilohertz 400 hertz

Along Track 1.0 degrees Along Track 2.0 degrees
Beamwidth

Across Track 1.0 degrees Across Track 2.0 degrees

Max Ping Rate 60 hertz 60 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

256
Number of
Beams

256

Max Swath Width 160 degrees 160 degrees

Depth Resolution 12.5 millimeters 12.5 millimeters

Manufacturer
Specified

100 meters 
Manufacturer
Specified

100 meters 
Depth Rating

Ship Usage 100 meters Ship Usage 100 meters

Manufacturer
Calibrations

Vessel Installed On 2702

Calibration Date 2015-11-16

System Accuracy
Tests

Vessel Installed On 2702

Methods Reference Surface

Results

Reference surfaces were performed in the vicinity of Cape Henry VA
in Anchorage B on March 17, 2016 (DN077). The 7125 400kHz sonars
were operated in dual head FM mode and compared to Launch 2702's
R2Sonic. Results are shown in the text and images below. The distribution
of depth differences (Launch 2702's R2Sonic 2022 minus S250's Dual
Reson 7125's): Depths from the R2sonic are on average 0.055 meters
shallower than depths from the Dual Reson 7125 system with a standard
deviation of 0.037 meters.

Snippets Sonar has snippets logging capability.
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Figure 9: R2Sonic 2022 flush-mounted on hull.

A.2.3 Single Beam Echosounders

No single beam echosounders were utilized for data acquisition.

A.2.4 Phase Measuring Bathymetric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.
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A.2.5 Other Echosounders

No additional echosounders were utilized for data acquisition.

Additional Discussion

A.3 Manual Sounding Equipment

A.3.1 Diver Depth Gauges

Manufacturer In-Situ Inc.

Model Rugged TROLL 100 / Rugged BaroTROLL

Description

The Rugged TROLL 100 is a non-vented (absolute) data logger that measures and
 records changes in water level, pressure, and temperature.  When post-processed
 with an accompanying CTD cast and tide value, accurate least depths on submerged
 objects can be obtained.  The Rugged BaroTROLL is a data logger used to measure
 and record barometric pressure, which is used to compensate for changes in water
 level due to barometric fluctuations.  Typically the BaroTROLL is not used for dive
 operations but may prove to be beneficial for least depth investigations in the future. 

Serial Numbers
349000 - Rugged TROLL 100

349047 - Rugged BaroTROLL

Calibrations No calibrations were performed.

Accuracy Checks

Serial Number 349000

Date 2014-04-15

Procedures

Sounding System Comparison - The DLDG was taped to the leadline

while recording and submerged to the seafloor for a measurement. A cast

was taken during the comparison and the data gathered were processed

using Velocipy. The DLDG results were 0.13 meters deeper than the

leadline measurement, 0.13 and 0.23 meters shallower than the port and

starboard 7125 values, respectively.

Correctors Correctors were not determined.

Non-Standard
Procedures

Non-standard procedures were not utilized.
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A.3.2 Lead Lines

Manufacturer Unknown

Model Traditional

Description
FERDINAND R. HASSLER is equipped with one lead line.  Lead lines are used
 for measurements near shore over submerged shoals and for echosounder depth
 comparisons. 

Serial Numbers RA6S

Calibrations No calibrations were performed.

Accuracy Checks

Serial Number RA6S

Date 2016-03-13

Procedures

The wet lead line was stretched with an amount of force equal to the

weight, on relatively flat ground and compared with a steel survey tape.

Values were recorded of true measurements at lead line markings.

Correctors
From the table of values obtained during the accuracy checks a table of correctors
was calculated. This table is stored locally aboard the FERDINAND R. HASSLER
and referenced when appropriate.

Non-Standard
Procedures

Non-standard procedures were not utilized.
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Figure 10: Leadline fitted with custom mud-shoe to limit penetration of soft bottoms. 

A.3.3 Sounding Poles

No sounding poles were utilized for data acquisition.

A.3.4 Other Manual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.4 Positioning and Attitude Equipment

A.4.1 Applanix POS/MV
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Manufacturer Applanix

Model POS/MV 320 V5

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for port
 hull.  Inertial motion unit (IMU) is located below water line close to the port side
 7125 wet end.  GPS antennae are located on flying bridge of S250.  The V5 system
 was installed on July 29, 2013. 

PCS

Manufacturer Applanix

Model POS/MV 320 V5

Description Rack mounted POS control system located in charting lab.

Firmware Version 8.15

Software Version 8.15

Serial Numbers

Vessel Installed

On
S250 Port

PCS s/n 5806

IMU

Manufacturer Applanix

Model Type 36

Description

Inertial measurement system consisting of three orthogonal

accelerometers and three orthogonal fiber-optic gyroscopes. Located in

port hull near 7125 wet end.

Serial Numbers

Vessel Installed

On
S250 Port hull

IMU s/n 2423

Certification
IMU s/n 2423

Certification Date 2013-06-26

Antennas

Manufacturer Trimble

Model GA830 GNSS/MSS

Description

GNSS/MSS antennae are used for position input as well as aiding the

heading solution. The antennae pair for the port system is the forward and

aft pair on the port side. The separation distance between the antennae

is approximately 2 meters. These new Trimble GA830 antennas were

installed on September 30th, 2015.

Serial Numbers

Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

S250 Port

(forward)
6997 Port Primary
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Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

S250 Port (aft) 5401 Port Secondary

GAMS Calibration
Vessel S250

Calibration Date 2016-02-11

Configuration
Reports

POS/MV configuration reports were not produced.

Manufacturer Applanix

Model POS/MV 320 V5

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for
 starboard hull.  Inertial motion unit (IMU) is located below water line close to the
 starboard side 7125 wet end.  GPS antennae are located on flying bridge of S250.  
 The V5 system was installed on July 29, 2013. 

PCS

Manufacturer Applanix

Model POS/MV 320 V5

Description Rack mounted POS control system located in charting lab.

Firmware Version 8.15

Software Version 8.15

Serial Numbers

Vessel Installed

On
S250 Starboard

PCS s/n 5807

IMU

Manufacturer Applanix

Model Type 36

Description

Inertial measurement system consisting of three orthogonal

accelerometers and three orthogonal fiber-optic gyroscopes. Located in

starboard hull near 7125 wet end.

Serial Numbers

Vessel Installed

On
S250 Starboard hull

S250 Starboard hull new

top hat

IMU s/n 2424 2672

Certification
IMU s/n 2424

Certification Date 2013-06-26

Antennas Manufacturer Trimble
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Model GA830 GNSS/MSS

Description

GNSS/MSS antennae are used for position input as well as aiding the

heading solution. The antennae pair for the port system is the forward and

aft pair on the port side. The separation distance between the antennae

is approximately 2 meters. These new Trimble GA830 antennas were

installed on, September 30th, 2015.

Serial Numbers

Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

S250 Starboard

(forward)
7000 Starboard Primary

S250 Starboard

(aft)
5415 Starboard Secondary

GAMS Calibration
Vessel S250

Calibration Date 2016-02-11

Configuration
Reports

POS/MV configuration reports were not produced.

Manufacturer Applanix

Model POS MV 320 v4

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for launch
 2702.  Inertial motion unit (IMU) is located underneath the false floor in the bilge
 compartment next to the coxswain station.  GPS antennae are located on cabin-top of
 2702.
 

PCS

Manufacturer Applanix

Model MV 320 v4

Description

The POS Computer System (PCS) comprises the processor, GPS receivers

and interface cards necessary to communicate with and process the

IMU and GPS data. Rack mounted system located in the survey rack

underneath the survey station counter in launch 2702.

Firmware Version 5.03

Software Version 5.8

Serial Numbers

Vessel Installed

On
2702

PCS s/n 3189
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IMU

Manufacturer Applanix

Model Type 2

Description

Serial Numbers

Vessel Installed

On
2702

IMU s/n 803

Certification IMU certification report was not produced.

Antennas

Manufacturer Trimble

Model 382AP GNSS

Description

GNSS antennae are used for position input as well as aiding the heading

solution. The antennae pair for the POS MV are located forward and aft

on the starboard side. The separation distance between the antennae is

approximately 2 meters.

Serial Numbers

Vessel Installed

On
Antenna s/n

Port or

Starboard

Primary or

Secondary

2702 Starboard

(aft)
60243869 Starboard Primary

2702 Port (fwd) 60243047 Port Secondary

GAMS Calibration
Vessel 2702

Calibration Date 2016-03-03

Configuration
Reports

POS/MV configuration reports were not produced.

A.4.2 DGPS

Description Hemisphere PGS MBX Kit 

Antennas

Manufacturer Hemisphere

Model MBX-4

Description

Serial Numbers
Vessel Installed On S250

Antenna s/n 1113139440044
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Receivers

Manufacturer Hemisphere

Model MBX-4

Description

Firmware Version 1.0

Serial Numbers
Vessel Installed On S250

Antenna s/n 1118144550001

Description Trimble DGPS Kit 

Antennas

Manufacturer Trimble

Model SPS361

Description

Serial Numbers
Vessel Installed On 2702

Antenna s/n 8838

Receivers

Manufacturer Trimble

Model SPS361

Description Auxillary DGPS Receiver

Firmware Version N/A

Serial Numbers
Vessel Installed On 2702

Antenna s/n 5449R80011

A.4.3 Trimble Backpacks

Trimble backpack equipment was not utilized for data acquisition.

A.4.4 Laser Rangefinders

Manufacturer Laser Technology Inc

Model TruPulse 360R

Description
Rugged and waterproof laser rangefinder which provides full measurement
 capabilities of distances, heights and azimuths. 

Serial Numbers 2557

DQA Tests DQA test was not performed.
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Figure 11: TruPulse 360R Laser Rangefinder

A.4.5 Other Positioning and Attitude Equipment

No additional positioning and attitude equipment was utilized for data acquisition.

A.5 Sound Speed Equipment
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A.5.1 Sound Speed Profiles

A.5.1.1 CTD Profilers

A.5.1.1.1 Sea-Bird SeaCat 19plus 350 meter and 3500 meter

Manufacturer Sea-Bird

Model SeaCat 19plus 350 meter and 3500 meter

Description Internal logging conductivity, temperature, and depth measuring devices. 

Serial Numbers
Vessel Installed On S250 S250 S250

CTD s/n 19P65591-6918 19P32914-4480 19P36399-4642

Calibrations

CTD s/n 6918 4480 4642

Date 2016-01-22 2016-01-22 2016-01-22

Procedures
Routine calibration

service

Routine calibration

service

Routine calibration

service
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Figure 12: Ferdinand R. Hassler CTD inventory
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A.5.1.2 Sound Speed Profilers

A.5.1.2.1 Rolls-Royce Brooke-Ocean MVP200

Manufacturer Rolls-Royce Brooke-Ocean

Model MVP200

Description

The cable was outfitted on August 18, 2014.

Towfish with AML Micro-CTD sensor SN-8609 was lost at sea on September 10,
 2016 after the cable parted while the towfish was in the docked position. The ship
 did not have a known spare on hand and performed manual CTDs for the remainder
 of the year. 

Serial Numbers
Vessel Installed On S250 S250

Sound Speed Profiler s/n 8609 8615

Calibrations

Sound Speed Profiler s/n 8609 8615

Date 2016-01-14 2013-08-10

Procedures Routine calibration service Certificate of Conformity



2016 DAPR Version 1.1           NOAA Ship Ferdinand R. Hassler                

29

Figure 13: MVP control station & winch
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Figure 14: MVP single sensor free fall fish. 

A.5.2 Surface Sound Speed

A.5.2.1 Sea-Bird 45 MicroTSG

Manufacturer Sea-Bird
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Model 45 MicroTSG

Description

Two SBE-45 thermosalinographs are installed to determine the sound velocity of
 the water at the sonar transducers.  This data is used to aid beam steering of the
 multibeam 7111 sonar system, and as a backup sound speed input available for
 beam steering of the multibeam 7125 sonar systems.  One is located in the starboard
 engine room, the other in the port.  Both units draw sampling water from the main
 cooling water line of the respective main engine.  The SBE-45s are configured to
 use their internal temperature sensors.  Both units are insulated with foam to ensure
 accurate temperature readings.  These devices calculate the sound speed from the
 measured salinity and temperature (using the Chen-Millero equation) of the sampled
 water.  A serial broadcast device sends the sound speed message from the SBE-45 to
 the RESON 7111 and SCS acquisition server. 

Serial Numbers
Vessel Installed On S250 Port S250 Starboard

Sound Speed Sensor s/n 4553332-0276 4553332-0277

Calibrations

Sound Speed Sensor s/n 4553332-0276 4553332-0277

Date 2015-04-02 2015-04-02

Procedures Routine calibration service Routine calibration service

A.5.2.2 RESON SVP-70

Manufacturer RESON

Model SVP-70

Description

Sound velocity probe developed for fixed-mount installation near RESON 7125
 transducer heads which uses a direct path echosounding technique that instantly
 compensates for temperature and pressure with internal sensors, providing accurate
 surface sound velocity measurements for beam steering. 

During the April-June 2016 drydock period, the port SVP-70 (S/N 2011276) was
 reinstalled. In August of 2016, the starboard SVP-70 sensor (S/N 2011278) began
 malfunctioning. The port SVP-70 was then fed to the starboard RESON 7125.
 The STBD SVP-70 was removed from the hull in December 2016 and sent to the
 manufacturer for repair.  

Serial Numbers
Vessel Installed On S250 Starboard hull S250 Port hull

Sound Speed Sensor s/n 2011278 2011276

Calibrations

Sound Speed Sensor s/n 2011278 2011276

Date 2014-03-12 2015-03-24

Procedures Routine calibration service Routine calibration service
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A.5.2.3 Valeport miniSVS

Manufacturer Valeport

Model miniSVS

Description

The miniSVS consists of a single circuit board controlling all sampling, processing
 and communications functions, and a sensor comprising a ceramic transducer, a
 signal reflector, and spacer rods to control the path length. The two are connected by
 a single coaxial cable. A titanium housing may be fitted, which provides waterproof
 protection to a depth in excess of 6000m. 

Serial Numbers
Vessel Installed On 2702

Sound Speed Sensor s/n 48002

Calibrations

Sound Speed Sensor s/n 48002

Date 2016-01-21

Procedures Routine calibration service

Additional Discussion

When in the deployed and docked position, the MVP sensor is towed at approximately the same height
 as the surface sound speed sensor.  As part of the system start up and watch turnover procedures as well
 as periodically through a survey watch, these values are verified to be in agreement.  Comparison casts
 between a SeaCat 19+ and the MVP are conducted once a project or if any issues with the MVP sensor are
 suspected.  The results of these tests are included in the Separates section of each survey.

A.6 Horizontal and Vertical Control Equipment

A.6.1 Horizontal Control Equipment

A.6.1.1 Base Station Equipment

Description Trimble NetR5 receiver used for long-term GPS base observations and correctors. 
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GPS Antennas

Manufacturer Trimble

Model Zephyr Geodetic Model 2

Description

The Zephyr Geodetic 2 is the antenna component for the NetR5 system
which incorporates a large Trimble Stealth™ Ground Plane, which
reduces multipath interference using technology similar to that used by
Stealth aircraft to hide from radar. The antenna is made with weather-
resistant materials and a low profile design, so the antenna can be used for
many years of continuous operation on a permanent installation.

 

Serial Numbers 1440921338

GPS Receivers

Manufacturer Trimble

Model NetR5 GNSS

Description

The Trimble NetR5 Reference Station is a multi-channel, multi-frequency
GNSS receiver designed for use as a stand-alone reference station or as
part of a GNSS infrastructure solution.

 

Firmware Version 4.03

Serial Numbers 4934K63376

UHF Antennas No UHF antennas were installed.

UHF Radios No UHF antennas were installed.

Solar Panels No solar panels were installed.

Solar Chargers No solar chargers were installed.

DQA Tests No DQA tests were performed.

A.6.1.2 Rover Equipment

No rover equipment was utilized for data acquisition.

A.6.2 Vertical Control Equipment

No vertical control equipment was utilized for data acquisition.

A.7 Computer Hardware and Software
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A.7.1 Computer Hardware

Manufacturer Dell

Model T5500

Description Processing Computers 

Serial Numbers

Computer s/n Operating System Use

FH-PROC1 Service Tag #

GFTQ8V1
Windows 7 Processing

FH-PROC2 Service Tag #

GFTR8V1
Windows 7 Processing

FH-PROC3 Service Tag #

GFTN8V1
Windows 7 Processing

FH-PROC4 Service Tag #

GFTM8V1
Windows 7 Processing

Manufacturer Dell

Model Precision Tower 7810

Description Acquisition Computers  

Serial Numbers

Computer s/n Operating System Use

FH-ACQ3 Service Tag #

84WYV52
Windows 7 Acquisition

FH-ACQ4 Service Tag #

84WXV52
Windows 7 Acquisition

Manufacturer Cybertron PC

Model Generic

Description Processing Computer 

Serial Numbers

Computer s/n Operating System Use

FH-PROC5 Service Tag #

FQC-00765
Windows 7 Processing

A.7.2 Computer Software

Manufacturer CARIS

Software Name HIPS/SIPS

Version 9.1
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Service Pack N/A

Hotfix 24

Installation Date 2016-05-01

Use Processing

Description
Data Processing (FH used Caris 9.0.21 for initial processing. Surveys from project
OPR-D304-FH-16 were transferred to the TJ for final processing and reporting where
9.1.4 was used)

Manufacturer CARIS

Software Name Bathy BASE Editor

Version 4.1

Service Pack N/A

Hotfix 21

Installation Date 2016-05-01

Use Processing

Description Data analysis and feature management

Manufacturer CARIS

Software Name Plot Composer

Version 5.3

Service Pack N/A

Hotfix N/A

Installation Date 2015-02-18

Use Processing

Description Mapping and plotting software

Manufacturer Applanix

Software Name POSPac

Version 7.2

Service Pack N/A

Hotfix N/A

Installation Date 2016-06-01

Use Processing

Description Position and Attitude processing software

Manufacturer NOAA



2016 DAPR Version 1.1           NOAA Ship Ferdinand R. Hassler                

36

Software Name Pydro

Version 16

Service Pack N/A

Hotfix N/A

Installation Date 2016-05-01

Use Processing

Description
Feature management, correlation, and report generator. Pydro automatically updates
throughout the project.

Manufacturer NOAA

Software Name Velocipy

Version 16

Service Pack N/A

Hotfix N/A

Installation Date 2015-02-16

Use Processing

Description
Feature management, correlation, and report generator, software update installed
for bug fixes and schema changes. Velocipy automatically updates with Pydro
throughout the project.

Manufacturer IVS 3D

Software Name Fledermaus

Version 7

Service Pack 5

Hotfix 3

Installation Date 2016-04-01

Use Processing

Description Data modeling

Manufacturer Hypack

Software Name Hypack/Hysweep

Version 2014

Service Pack 0

Hotfix 16

Installation Date 2014-02-18

Use Acquisition
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Description Data logging

Manufacturer Applanix

Software Name POSView

Version 8.46

Service Pack N/A

Hotfix N/A

Installation Date 2015-12-14

Use Acquisition

Description Positioning

Manufacturer Synergy

Software Name Synergy

Version 1.4.14

Service Pack N/A

Hotfix N/A

Installation Date 2014-02-17

Use Acquisition

Description Shared mouse and keyboard between acquisition systems

A.8 Bottom Sampling Equipment

A.8.1 Bottom Samplers

A.8.1.1 Ponar Wildco 1728

Manufacturer Ponar Wildco

Model 1728

Description
Grab sampler triggered by contact with sea floor.  A custom mount equipped with
 camera and light was designed for the acquisition of video of the seafloor.  
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Figure 15: Ponar grab sampler
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Figure 16: Camera with custom mount allowing for high quality video of the seafloor

A.8.1.2 Go Pro Hero 3

Manufacturer Go Pro

Model Hero 3

Description

Video camera rigged as a drop camera to function along with grab sampler. 
 The camera contains a 12 MP sensor capable of 1440p at 48fps.  This camera
 supplements the data gathered with the grab sampler, and allows the field unit to
 provide data from null samples from the sediment sampler. 

Figure 17: Go Pro video camera.

B Quality Control
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B.1 Data Acquisition

B.1.1 Bathymetry

B.1.1.1 Multibeam Echosounder

Multibeam data on S250 are logged locally on the RESON topside machines in s7k format.  Multibeam
 data are also acquired through Hypack/Hysweep in HSX format for bathymetry, though these files are only
 used in the event of errors in the s7k file and are otherwise discarded.  The HSX format includes sounding
 solutions, navigation and attitude data.  Ship navigation and survey line monitoring are performed with
 Hypack/Hysweep.  The s7k format includes sounding solutions, navigation, attitude, and backscatter snippet
 data.  This record is configured to include the following RESON datagrams: 1003: Position; 1012: Roll,
 Pitch, Heave; 1013: Heading; 7000: 7k Sonar Settings; 7004: 7k Beam Geometry; 7006: 7k Bathymetric
 Data; 7008: Bathymetry (For UI Display Only); 7017: Bathymetry (RAW for hydrography); 7027: 7k
 Generic Watercolumn Data (used for snippets backscatter) and 7503: Remote Control Sonar Settings.  

All multibeam sonars are configured in equidistant ("Best Coverage" in newest RESON version) beam
 steering mode.  The opening angle of the 7125 systems is configured based on analysis of coverage, speed,
 and expected sound speed refraction errors for each survey.  This angle typically varies between 120 and
 140 degrees.  Power, gain, and TVG parameters are typically set for a particular project and changes during
 acquisition are minimal. 

The RESON units are interfaced with the acquisition machines through UDP LAN connections over a
 dedicated network switch (NetGear ProSafe Gigabit Switch).  Position and attitude data is passed from
 the POS-MV to both the RESON machines and to the acquisition computers through dedicated network
 switches (NetGear ProSafe Gigabit Switch).  There is a dedicated switch for the port and starboard POS
 systems.  Time is passed from the POS to the RESON machines via an RS232 serial connection and a PPS
 pulse via a coaxial cable with BNC connectors.  The starboard POS is interfaced with the starboard 7125
 and the 7111, which is located in the starboard hull.  The port POS is interfaced to the port 7125.  A diagram
 of this configuration is included with the support files to this report and illustrated in Figure 20. 

Data acquired on Launch 2702 is processed by the Sonar Interface Module and delivered to the acqusition
 machine through a direct ethernet connection and logged using Hypack 2015 in the .HSX and R2Sonic .R2S
 formats. A swath angle of 120 degrees with the sector rotated 20 degrees to counteract the mounting angle
 on the hull is used as standard procedure. Bottom sampling is set to equidistant quad which distributes
 soundings evenly in the x and y directions. Roll stabilization is used and frequency can be adjusted on
 the fly from 200-400kHz.  The sonar has the ability to log TruePix (similar to sidescan with 3D relief),
 Snippets, and Water Column data.
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Figure 18: Ship survey systems wiring diagram
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Figure 19: 2702 survey systems wiring diagram

B.1.1.2 Single Beam Echosounder

Single beam echosounder bathymetry was not acquired.

B.1.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not acquired.

B.1.2 Imagery

B.1.2.1 Side Scan Sonar

Side scan sonar imagery was not acquired.
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B.1.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.3 Sound Speed

B.1.3.1 Sound Speed Profiles

Seabird SBE 19plus and MVP sound speed profilers are used regularly to collect sound speed data for
 ray tracing corrections for the multibeam sonar systems. The MVP is the primary method of sound speed
 profiling unless fishing gear or other potential dangers are deemed high enough risk that the MVP could
 be lost.  To mitigate the risk of loss "running" casts are performed, where the ship recovers the MVP
 immediately upon a successful cast.  If it is deemed that a "running" cast is too high risk a "static" cast
 will be performed, where the ship will stop all way and manually winch out to the desired depth before
 recovering the towfish.  CTD casts are performed if there is not an MVP qualified operator available on
 watch.  Data is retrieved from the Seabird CTDs with a serial connection to a processing computer.  Data
 from both the Seabirds and MVP are processed through the NOAA in-house program Velocipy to give
 CARIS .svp formatted sound velocity profiles.  All .svp profiles for a survey sheet are concatenated to one
 master file for a survey.

Casts are taken at least every four hours, but typically far more frequently.  The interval between casts
 is typically between ten minutes and four hours based on the observed variability between casts and is
 discussed in the Descriptive Report of each survey.
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Figure 20: Example of sound speed samples taken in a survey area

B.1.3.2 Surface Sound Speed

Surface sound speed for both RESON 7125 systems is fed from individual SVP-70 sound velocity sensors
 mounted near each transducer.  While operating in dual-head mode the starboard SVP-70 feeds both the
 master and slave.  Seabird TSG 45 thermosalinograph measures sea surface conductivity and temperature
 and then calculates surface sound speed for the RESON 7111.  Surface sound speed is typically compared
 daily between the real time MVP output and the starboard SVP-70 sensor by the acquisition watch.  Data
 from all surface sound speed sensors can be fed into SCS for real time comparison and are recorded during
 MVP or CTD casts to perform surface sound speed DQAs.

The R2Sonic 2022 uses a surface sound speed input from the Valeport miniSV that is mounted in the sonar
 void along with the sonar receiver and transmitter. During regular launch operations, periodic DQAs with
 the CTDs along with visual comparisons cast to cast by the acquisition operator.

B.1.4 Horizontal and Vertical Control

B.1.4.1 Horizontal Control
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Applanix POS/MV files are logged using both the USB logging function and Ethernet logging function. 
 Both files contain the same data records including attitude, heading, position, and velocity data as stated in
 section 3.4.1 of the FPM.  During acquisition, the navigation solution status is constantly monitored by the
 acquisition watch stander.

The internal (USB) logged files are size limited, therefore files submitted typically start with the .000
 extension and increment upwards (e.g. .001, .002, .003, ...).  There are approximately 240 files generated
 during 24 hours of acquisition.  The Ethernet logged files are typically broken at approximately UTC noon
 and midnight each day to yield two files per hull for a survey day.  

Real-time USCG DGPS correctors are used for all acquisition.  Specific DGPS stations are noted in the DR
 accompanying each survey.

B.1.4.2 Vertical Control

Preliminary, observed, and verified water levels are downloaded using FetchTides and applied to the data
 using CARIS HIPS Load Tide function.  For data submission, depth data are reduced to MLLW either
 through application of Verified Water levels and Verified Tidal Zoning or using GPS derived vertical
 positions and the VDatum model.  Refer to individual sheet DRs for detailed methods and additional
 information.

B.1.5 Feature Verification

Feature verification data were not acquired.

B.1.6 Bottom Sampling

Bottom Sampling followed guidelines set forth in sections 7.1 of the HSSD and 2.5.4.2.1 of the FPM. 
 Unless specified otherwise in the DR, bottom sample locations are guided by analysis of the backscatter and
 bathymetry of the survey area.  Refer to individual sheet DR for additional information.

B.1.7 Backscatter

Backscatter is acquired in the 7008 record logged in the .s7k files directly from the RESON 7125 processors.
  For the 7125 400kHz systems, snippet size is set to 25 samples in water depths less than 50 meters and to
 50 samples in depth greater than 50 meters.  The 7125 200kHz system has snippets size set to 100 in depths
 less than 100 meters and 200 in all depths greater than 100 meters.  7111 snippet size is set to 40 samples in
 depths less than 80 meters, 80 samples in depths between 150 and 300 meters, and 120 samples in deeper
 depths.  All processing of backscatter is done using the FMGT module of the QPS Fledermaus package. 
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B.1.8 Other

No additional data were acquired.

Additional Discussion

FERDINAND R. HASSLER maintains a continuous manned survey watch during all survey acquisition.
  The watch stander is in constant communication with the bridge and monitors the performance of all
 systems.  Thresholds set in Hypack/Hysweep, POSview, RESON, and SonarPro alert the watch stander
 by displaying alarm messages when error thresholds or tolerances are exceeded.  Alarm conditions that
 may compromise survey data quality are corrected and then noted in acquisition log.  Warning messages
 such as the temporary loss of differential GPS, excessive cross track error, or vessel speed approaching
 the maximum allowable survey speed are addressed by the watch stander and corrected before further data
 acquisition occurs.

B.2 Data Processing

B.2.1 Bathymetry

B.2.1.1 Multibeam Echosounder

Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.

Raw .s7k (Reson 7125s) and .HSX/.R2S (R2Sonic 2022) multibeam data were converted to CARIS HIPS
 HDCS format using established and internally documented settings.  After TrueHeave, sound speed, water
 level correctors, and SBETS are applied to all lines, GPS Tides are calculated using the HSD Operations
 Branch provided VDatum separation model and the lines are merged.  Once lines are merged, Total
 Propagated Uncertainty (TPU) is computed using settings documented for each survey in the Descriptive
 Report.  Default CARIS device models (devicemodels.xml) are used during processing.

The general resolution, depth ranges, and Combined Uncertainty and Bathymetric Estimator (CUBE)
 parameter settings outlined in section 5.2.2.2 of the HSSD and section 4.2.1.1.1.1 of the FPM are used
 for surface creation and analysis.  If these depth range values for specific resolutions require adjustment
 for analysis and submission of individual surveys then the required waiver from NOAA HSD Operations
 is requested.  A detailed listing of the resolutions and the actual depth ranges used during the processing
 of each survey, along with the corresponding fieldsheet(s), is provided in the Descriptive Report of each
 survey.
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BASE surfaces were created using the CUBE algorithm and parameters contained in the NOAA
 CUBEParams_NOAA.xml file as provided in Appendix 4 of the FPM.  The CUBEParams_NOAA.xml
 file is included with the HIPS Vessel Files with the individual survey data.  The NOAA parameter
 configurations for resolutions 0.5-16 meters are used.

Multibeam data were reviewed and edited in HIPS Subset Editor as necessary.  The finalized BASE surfaces
 and CUBE hypotheses guided directed data editing at the appropriate depth range in subset editor.  The
 surfaces and subset editor views were also used to demonstrate coverage and to check for errors due to tides,
 sound speed, attitude and timing.

Vessel heading, attitude, and navigation data were reviewed with the HIPS navigation editor and attitude
 editor as deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in heading, attitude, or
 navigation data were manually rejected or interpolated for small periods of time.  Any editing of this nature
 is outlined in the Descriptive Report for the particular survey.

Either the Density or the Density & Locale method for hypothesis disambiguation is typically used.  This
 follows section 4.2.1.1.1 of the FPM as available disambiguation methods.  The disambiguation method can
 be seen in each individual layers properties and can be modified if desired.

The surface filtering function in CARIS HIPS is not utilized routinely.  If utilized, the individual Descriptive
 Report lists the confidence level settings for standard deviation used and discuss the particular way the
 surface filter was applied.

Designated soundings were selected as outlined in section 5.2.1.2 of the HSSD.

IHO child layers were created using the following two formulas for IHO_1 and IHO_2, respectively; -
Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5) and -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5).  IHO_1
 is created for all soundings less than 100 meters while IHO_2 is for 100 meters and deeper.  This layer
 is then exported and run through an application which computes statistics.  The results are reported and
 analyzed in each sheets' individual DR, but the layers are not submitted with the survey. 

Additionally, a combined resolution surface was created and reviewed in 3-D mode using one of the
 following programs; CARIS HIPS, CARIS Base Editor or IVS Fledermaus, to ensure that the data are
 sufficiently free of artifacts and is a reasonable model of the sea floor. 
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Figure 21: MBES flow diagram

B.2.1.2 Single Beam Echosounder

Single beam echosounder bathymetry was not processed.

B.2.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not processed.

B.2.1.4 Specific Data Processing Methods

B.2.1.4.1 Methods Used to Maintain Data Integrity

Quality control logs were used to track and communicate problems during processing.

B.2.1.4.2 Methods Used to Generate Bathymetric Grids

All methods used to generate final bathymetric grids are followed as put forth in section 4.2 and all relevant
 subsections of the FPM.
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B.2.1.4.3 Methods Used to Derive Final Depths

Methods Used

Cleaning Filters

Gridding Parameters

Surface Computation Algorithms

Description
Filters were used on a case by case basis as determined by the hydrographer, refer to
individual sheet DRs for more information.

B.2.2 Imagery

B.2.2.1 Side Scan Sonar

Side scan sonar imagery was not processed.

B.2.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not processed.

B.2.2.3 Specific Data Processing Methods

B.2.2.3.1 Methods Used to Maintain Data Integrity

Processing logs were used to record and communicate problems from acquisition to final processing.

B.2.2.3.2 Methods Used to Achieve Object Detection and Accuracy Requirements

Range of the SSS, XTE, speed of vessel collecting data, and repetitious processing examinations were all
 used
to ensure that object detection and accuracy requirements are met.

B.2.2.3.3 Methods Used to Verify Swath Coverage

Swath coverage is verified through construction of side scan mosaics. During acquisition, the outer portions
of the swath are monitored for refraction artifacts. If an apparent refraction artifact impacts object
detection ability and cannot be eliminated through adjustment of fish height, the range scale is reduced.

B.2.2.3.4 Criteria Used for Contact Selection

In CARIS SIPS, if an apparent shadow measures greater than 1.0 meters a contact is chosen for development
by MBES.
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B.2.2.3.5 Compression Methods Used for Reviewing Imagery

No compression methods were used for reviewing imagery.

B.2.3 Sound Speed

B.2.3.1 Sound Speed Profiles

Daily sound speed profiles from the SBE and MVP profilers were processed with Velocipy after acquisition.

Project OPR-G309-FH-16 Note:
Based on feedback from the Atlantic Hydrographic Branch (AHB), the Ferdinand R. Hassler discovered
 that one element of the recommended Caris processing workflow was not followed throughout project
 OPR-G309-FH-16. The Caris Sound Velocity Correction (SVC) process was conducted before but not after
 loading Smoothed Best Estimates of Trajectory (SBETs). It is recommended to perform the SVC process
 after loading SBETs in order for the ray tracing to account for the updated motion and attitude information.
 A copy of survey H12932 was re-processed to assess the effect of not applying SVC after loading SBETs.
 As viewed in Caris Subset Editor, the vertical difference between processing methods ranged from 0.005 -
 0.010 meters in all sampled areas, including two wrecks. The SVC processing methods were also compared
 using 2 meter and 4 meter difference surfaces. In the 2 meter difference surface, the depths differ by -8.17
 to 3.07 meters, with a mean difference of 0.00 meters and a standard deviation of 0.00 meters, and 95%
 of nodes exhibit a depth difference of ±0.01 meters. In the 4 meter difference surface, the depths differ by
 -0.74 to 0.62 meters, with a mean difference of 0.00 meters and a standard deviation of 0.00 meters, and
 95% of nodes exhibit a depth difference of ±0.01 meters. The high values in the difference surfaces are
 isolated and limited to features and steep slopes. A detailed review confirmed that the high values in the
 difference surfaces are entirely the result of CUBE gridding inconsistencies and small horizontal shifts
 in the grid node structure rather than actual vertical differences in the sounding data. The results of this
 testing were discussed with HSD Operations and AHB. Based on the limited magnitude of the error, it was
 concluded that re-processing the entire project was unnecessary. The ship’s Caris processing SOP has been
 updated to reflect the recommended SVC workflow. Details on the analysis can be found in the Appendix.

B.2.3.1.1 Specific Data Processing Methods

B.2.3.1.1.1 Caris SVP File Concatenation Methods

CTD profiles from the Seabird SBE 19-plus and AML Micro-CTD were processed using the NOAA
 developed program Velocipy.  From each system, sound speed profiles are extracted and archived as both
 individual and concatenated CARIS SVP files.

B.2.3.2 Surface Sound Speed

The SBE-45s were configured to average four samples and report the result once a second.  No additional
 filters are applied. 
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B.2.4 Horizontal and Vertical Control

B.2.4.1 Horizontal Control

Fixed USCG DGPS stations were used for all real-time horizontal control.  If post-processed GPS techniques
 were used to improve horizontal and vertical control, specific information is included in the Descriptive
 Report and/or the project's Horizontal and Vertical Control Report.

If USB logged TrueHeave files contained IMU data gaps or other errors apparent during post processing,
 the Ethernet-logged files may be examined and used if free from gaps.  If this is the case both files will be
 submitted with the GNSS data.

B.2.4.2 Vertical Control

CO-OPS zoned water levels utilizing water level observations from fixed, continuously operating NOAA
 tide gages are used for reduction of data to MLLW.  Predicted water levels are applied during preliminary
 processing.  Before submission, verified water levels are applied to all tidally corrected data.  If post-
processed GPS techniques are used to improve vertical control, specific information is included in the
 Descriptive Report and/or the project's Horizontal and Vertical Control Report.

B.2.5 Feature Verification

Features were processed using CARIS BASE Editor software and were included with submitted in the
 survey's final feature file (FFF) in S-57 .000 format. The FFF includes all features; buoys, rocks, wrecks,
 bottom samples, etc., addressed within the limits of each individual sheet.

B.2.6 Backscatter

All backscatter was processed from acquired RESON .s7k or Hypack .7k files.  All backscatter processing
 was performed with QPS Fledermaus Geocoder Toolbox and a mosaic calculated with default processing
 parameters.  RESON TVG plugins were used for all processing steps.

B.2.7 Other
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No additional data were processed.

B.3 Quality Management

Standard Operating Procedures (SOPs) and checklists are followed by personnel throughout the survey to
 ensure consistent high quality data and products.

Data are reviewed for artifacts and errors during daily processing, and also reviewed by the Field Operations
 Officer and/or Hydrographic Senior Survey Technician daily.  Before any data is to be submitted it is
 reviewed independently by at least three experienced hydrographers who are signatories to the Descriptive
 Report.

B.4 Uncertainty and Error Management

TPU is processed using the following settings.

B.4.1 Total Propagated Uncertainty (TPU)

B.4.1.1 TPU Calculation Methods

TPU is calculated in CARIS HIPS using the Compute TPU tool.  Project specific values for tide and sound
 speed are entered and used over the duration of each project.  

B.4.1.2 Source of TPU Values

Error values for the multibeam and positioning systems were compiled from manufacturer specifications
 sheets for each sensor and from values set forth in section 4.2.3.8 of the 2014 FPM.

B.4.1.3 TPU Values

Vessel S250 (Port)

Echosounder RESON 7125 200 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees
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Navigation
Position

0.500 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.100 degrees

Pitch 0.020 degrees

Roll 0.020 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Port)

Echosounder RESON 7125 400 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5.000 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

0.500 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters
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MRU Alignment

Gyro 0.027 degrees

Pitch 0.04 degrees

Roll 0.04 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder RESON 7111 100 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5.000 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

1.000 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.100 meters

y 0.100 meters

z 0.100 meters

MRU Alignment

Gyro 0.130 degrees

Pitch 0.030 degrees

Roll 0.030 degrees

Vessel

Speed 0.030 meters/second

Loading 0.040 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder RESON 7125 200 kilohertz
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TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

1.000 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.080 degrees

Pitch 0.010 degrees

Roll 0.010 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder RESON 7125 400 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

1.000 meters
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Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.090 degrees

Pitch 0.030 degrees

Roll 0.030 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

B.4.2 Deviations

There were no deviations from the requirement to compute total propagated uncertainty.

Additional Discussion

MRU Align StdDev gyro and MRU Align StdDev Roll/Pitch were derived during patch test processing.
 Typically several individuals come up with five values for timing, pitch, roll, and yaw. A standard deviation
 is computed from the different values obtained by each individual. The standard deviation from each
 individual is then averaged and used as the MRU alignment error (standard deviation of all the independent
 measurements divided by the square root of the number of measurements).

S250:                            MRU Align StdDev gyro        MRU Align StdDev Roll/Pitch

Port 7125 400kHz:       0.070m                                     0.080m
Port 7125 200kHz:       0.060m                                     0.060m
Stbd 7125 400kHz:       0.090m                                     0.060m
Stbd 7125 200kHz:       0.120m                                     0.020m

2702:

R2Sonic:                       0.090m                                      0.020m
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C Corrections To Echo Soundings

C.1 Vessel Offsets and Layback

C.1.1 Vessel Offsets

C.1.1.1 Description of Correctors

No description was provided.

C.1.1.2 Methods and Procedures

Sensor offsets are measured with respect to the vessel's reference point.  These offsets are derived from the
 full survey performed in the shipyard, a partial survey performed by NGS personnel and measurements/
verifications performed by FERDINAND R. HASSLER personnel.  All offsets are tracked and updated as
 needed on a spreadsheet submitted with the appendices of this report.  

The port IMU serves as the reference point for the port-only 7125 HSX configuration, the port 7125 s7k
 configuration and the side scan sonar. For all other vessel configurations the starboard IMU is the reference
 point.

POS GPS antennae pairs are mounted to a 2 meter length of channel extrusion in a fore and aft orientation.

C.1.1.3 Vessel Offset Correctors

Vessel S250 Port

Echosounder RESON 7125 400 kilohertz

Date 2013-07-01

Offsets MRU to Transducer

x -1.244 meters

y 0.362 meters

z 1.349 meters

x2 N/A

y2 N/A

z2 N/A
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Nav to Transducer

x -2.246 meters

y -2.351 meters

z 14.269 meters

x2 N/A

y2 N/A

z2 N/A

Transducer Roll
Roll 4.500 degrees

Roll2 N/A

Vessel S250 Port (For use with STBD POS data)

Echosounder RESON 7125 400 hertz

Date 2013-07-01

Offsets

MRU to Transducer

x -13.490 meters

y 0.338 meters

z 4.311 meters

x2 N/A

y2 N/A

z2 N/A

Nav to Transducer

x -10.386 meters

y -2.362 meters

z 46.699 meters

x2 N/A

y2 N/A

z2 N/A

Transducer Roll
Roll 4.5 degrees

Roll2 N/A

Vessel S250 Starboard

Echosounder RESON 7125 400 kilohertz

Date 2013-07-01

Offsets MRU to Transducer

x 1.424 meters

y 0.380 meters

z 1.358 meters

x2 N/A

y2 N/A

z2 N/A
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Nav to Transducer

x 4.528 meters

y -2.320 meters

z 14.278 meters

x2 N/A

y2 N/A

z2 N/A

Transducer Roll
Roll -4.500 degrees

Roll2 N/A

Vessel S250

Echosounder RESON 7111 100 kilohertz

Date 2013-07-01

Offsets

MRU to Transducer

x 1.203 meters

y 11.608 meters

z 0.977 meters

x2 N/A

y2 N/A

z2 N/A

Nav to Transducer

x 4.307 meters

y 8.908 meters

z 13.897 meters

x2 N/A

y2 N/A

z2 N/A

Transducer Roll
Roll 0.000 degrees

Roll2 0.000 degrees

Vessel S250

Echosounder
Odom Echotrac CV200 - Transducer 1 = Starboard hull (200 kHz), Transducer 2 =
Port hull (24 kHz) 24 kilohertz

Date 2013-07-01

Offsets MRU to Transducer

x -0.455 meters

y 4.620 meters

z 1.383 meters

x2 -12.701 meters

y2 4.620 meters

z2 1.381 meters
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Nav to Transducer

x 2.649 meters

y 1.920 meters

z 14.303 meters

x2 -9.597 meters

y2 1.920 meters

z2 14.301 meters

Transducer Roll
Roll 0.000 degrees

Roll2 0.000 degrees

Vessel 2702

Echosounder R2Sonic 2022 200 kilohertz

Date 2016-09-11

Offsets

MRU to Transducer

x 0.237 meters

y -0.833 meters

z 0.407 meters

x2 0 meters

y2 0 meters

z2 0 meters

Nav to Transducer

x 0.759 meters

y -0.309 meters

z -2.932 meters

x2 0 meters

y2 0 meters

z2 0 meters

Transducer Roll
Roll 20.000 degrees

Roll2 N/A

C.1.2 Layback

C.1.2.1 Description of Correctors

Layback is calculated in CARIS from the cable-out and fish depth. Cable-out is output from a cable counter
 and recorded in the .sdf file.  The side scan cable is marked at 12 meters and is deployed to this position on
 launching. The cable counter is reset to zero at this position and the 12 meter offset applied in SonarPro.
 Thus, the cable out value in the .sdf file is the correct value for the cable between the tow point and the
 towfish.

C.1.2.2 Methods and Procedures

No layback correctors are applied in the HVF
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C.1.2.3 Layback Correctors

Vessel S250

Echosounder Klein 5250 455 kilohertz

Date 2013-07-01

Layback
Towpoint

x 7.161 meters

y -26.032 meters

z -9.347 meters

Layback Error 0.00 meters

Additional Discussion

C.2 Static and Dynamic Draft

C.2.1 Static Draft

C.2.1.1 Description of Correctors

Because of her SWATH design, FERDINAND R. HASSLER is particularly susceptible to loading and trim.
  While underway, the ballast is actively managed to maintain the draft at the design draft of 3.77 meters.
  During typical survey operations, HASSLER burns approximately 4,000 liters of diesel per day.  At a
 density of 0.83 kilograms/liter this is approximately 3.3 metric tons of fuel per day.  At design draft of 3.77
 meters, 1.3 metric tons is required to submerge an additional 0.01 meters of the hull in salt water.  The daily
 fuel burn would thus account for 0.03 meters of variation in the draft.  Ballast is adjusted daily to account
 for fuel burn and the levels in other tanks.  Uncertainty is estimated at 0.05 meters. 

C.2.1.2 Methods and Procedures

The waterline to reference point is calculated from the vessel offset survey and the vessel draft marks.

C.2.2 Dynamic Draft

C.2.2.1 Description of Correctors
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Dynamic draft is calculated as the dynamic height of the vessel reference point as a function of vessel speed
 compared to the height at rest.  This correction is applied during CARIS processing. 

C.2.2.2 Methods and Procedures

An ellipsoidally referenced dynamic draft measurement (ERDDM) was performed on following guidelines
 in the 2014 FPM on February 21, 2016 (Dn28) for vessel S250.  An area was selected about 30NM off
 the VA/NC coast where the slope of the geoid was minimal.  Speeds from 6 to 13 knots were run in one
 direction.  The ship was then turned to the reciprocal heading, brought to a complete stop, and then the
 speeds from 6 to 13 knots were run in the opposite direction. 

The fourth order polynomial results for the dynamic draft curves from the port and starboard side were
 averaged. The 2016 results and comparisons between 2011 - 2016 can be found included in the attached
 appendices.  Results from the last three years were averaged for use as the dynamic draft corrector values
 for 2016.

 Similar methods were used in performing the ERDDM for launch 2702 which was performed in the York
 River on March 3, 2016 (Dn063). This was the first ERDDM performed on the vessel, therefore no previous
 years values were available for averaging. The 2016 results were used for dynamic draft correctors.
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Figure 22: S250 dynamic draft derived from ERDDM methods. Positive values are displacements
of the IMU towards the sea floor. Thin lines are results from port and starboard head for third

and fourth order polynomial fits. Black bold line is dynamic draft value used for both hulls.
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Figure 23: S250 dynamic draft derived from ERDDM methods comparison from years 2011 - 2016.
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Figure 24: 2702 dynamic draft derived from ERDDM methods. Positive values
are displacements of the IMU towards the sea floor. Thin lines are results
from port and starboard head for third and fourth order polynomial fits.

C.2.2.3 Dynamic Draft Correctors

Vessel S250

Date 2016-02-21

Dynamic
Draft Table

Speed Draft

0.0 0.000

0.5 0.00

1.0 -0.01

1.5 -0.03

2.0 -0.04

2.5 -0.04
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Speed Draft

3.0 -0.04

3.5 -0.02

Vessel S250

Date 2015-06-14

Dynamic
Draft Table

Speed Draft

4.0 -0.01

4.5 -0.02

5.0 0.05

5.5 0.08

6.0 0.10

6.5 0.12

Vessel 2702

Date 2016-03-03

Dynamic
Draft Table

Speed Draft

0.00 0.00

0.5 -0.02

1.0 -0.02

1.5 -0.01

2.0 -0.01

2.5 0.01

3.0 0.01

3.5 0.01

4.0 -0.01

4.5 -0.04

5.0 -0.08

5.5 -0.14

6.0 -0.21

6.5 -0.29

C.3 System Alignment

C.3.1 Description of Correctors

No description was provided.
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C.3.2 Methods and Procedures

Methods and Procedures used follow recommendations given in Section 1.5 of the 2014 FPM.

C.3.3 System Alignment Correctors

Vessel S250

Echosounder RESON 7125 Starboard 400 megahertz

Date 2016-07-09

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.620 degrees

Roll 0.070 degrees

Yaw 0.700 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder RESON 7125 Starboard 200 kilohertz

Date 2016-07-09

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.310 degrees

Roll 0.060 degrees

Yaw 0.690 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder RESON 7125 Port 400 kilohertz

Date 2016-07-09
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Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.380 degrees

Roll -0.140 degrees

Yaw -0.360 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder RESON 7125 Port 200 kilohertz

Date 2016-07-09

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.370 degrees

Roll -0.140 degrees

Yaw -0.220 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder RESON 7111 100 kilohertz

Date 2014-04-16

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.86 degrees

Roll 0.010 degrees

Yaw 1.170 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel 2702

Echosounder R2Sonic 2022 400 kilohertz

Date 2016-03-03
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Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -1.500 degrees

Roll -1.290 degrees

Yaw -0.010 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Additional Discussion

The RESON 7111 sonar was inoperable during the 2016 field season and was not calibrated during 2016. 
 The 7111 patch test values are retained here from the 2014 calibration period for reference only.

C.4 Positioning and Attitude

C.4.1 Description of Correctors

No description was provided.

C.4.2 Methods and Procedures

Vessel navigation and attitude is measured by the POS/MV and recorded in the Hysweep .hsx file and the
 RESON .s7k file.  Pitch is applied real-time to the RESON 7111.  Navigation and attitude measurements not
 applied in real time are applied during post processing in CARIS HIPS using the attitude data recorded in
 the .hsx or .s7k file.  

The POS/MV TrueHeave data is logged within the POS/MV .000 files and applied in CARIS HIPS during
 post processing using the "Apply Delayed Heave" function.  TrueHeave is a forward-backward filtered
 heave corrector as opposed to the real time heave corrector, and is fully described in section 6 of the POS/
MV V5 User Guide 2011 and V4 User Guide 2009. 

In most cases the Hassler used the Fugro MarineStar satellite based corrector service to provide realtime
 correction to the horizontal position and ellipsoid height for all data acquisition and initial processing. The
 corrector signal is received on the L1 channel of the POS/MV primary GPS antenna and logged directly
 into the POS/MV. The POS files produced during acquisition are then processed through the POSPac MMS
 software to produce an SBET in the WGS84 reference frame and an RMS file containing the realtime
 uncertainty estimates of the position and attitude data. 

Alternatively, if Marinestar service isn't available, post processing of POS/MV kinematic .000 files using
 Applanix POSPac MMS and POSGNSS software using either IN-Fusion SmartBase, IN-Fusion SingleBase
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 or Precise Point Positioning (PPP) processing modes.  After processing and quality control analysis of
 the post-processed SBET files is complete, the SBET and SMRMSG files are applied to the HDCS data
 in CARIS HIPS using the "Load Attitude/Navigation Data" and "Load Error Data" processing tools,
 respectively.  

The heave lever arms for S250 are configured to a point on the centerline of the vessel between the two POS
 IMUs.  This was done to prevent long-term static roll angles from causing a steady state heave offset.

C.5 Tides and Water Levels

C.5.1 Description of Correctors

No description was provided.

C.5.2 Methods and Procedures

Unless otherwise noted in the survey Descriptive Report (DR) and/or project Horizontal and Vertical Control
 Report (HVCR), the vertical datum for all soundings and heights is Mean Lower Low Water (MLLW). 
 Predicted, preliminary, and/or verified water level correctors from the primary tide station(s) listed in the
 Project Instructions may be downloaded from the CO-OPS website and used for water level corrections
 during the course of the project.  These tide station files are collated to include the appropriate days of
 acquisition and then converted to CARIS .tid file format using FetchTides.

Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone definition file
 (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied by CO-OPS.  Upon
 receiving final approved water level data, all data are reduced to MLLW using the final approved water
 levels as noted in the individual survey's DR.

A Horizontal and Vertical Control Report (HVCR) was not created for this project.

Newer methods for handling vertical control are being developed and, if utilized, are explained in more
 detail in the survey DR.

C.6 Sound Speed

C.6.1 Sound Speed Profiles

C.6.1.1 Description of Correctors
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No description was provided.

C.6.1.2 Methods and Procedures

Seabird .cnv and MVP .bot files are collected when necessary and converted to .svp files using NOAA's
 Pydro/Velocipy program.  These .svp files are concatenated into one sheet specific master file per project
 which is then applied to HDCS data using a specified method.  This method of applying sound speed to data
 is listed in the sheet's processing log included in the Separates submitted with the individual survey.

C.6.2 Surface Sound Speed

Surface sound speed correctors were not applied.
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H12932 Re-SVC Process Analysis 
Approaches to Wilmington (OPR-G309-FH-16) sheet H12932 assigned to Ferdinand Hassler was selected to 
conduct an analysis of the need to re-SVC the sheets in this project after SBET application. This sheet was 
chosen due to its size and the fact that it contains multiple wrecks and bottom features. The steps for the 
analysis are below 
• Ensure designated soundings in the original survey were correct 
• Ensure original surfaces were up to date 
• Copy the original project. Rename the original project _OLD 
• Re-SVC the copied project 
• Re-merge the new project 
• Ensure designated soundings in the new project were correct 
• Create surfaces 
• Difference new and old surfaces 
 
Conclusion: 
 95% of nodes in the 2m difference surface have a value of 0.01 meters or less 
 95% of nodes in the 4m difference surface have a value of 0.01 meters or less 
 Largest differences were seen over wrecks or bottom topography.  
 Nodal analysis over features is not indicative of actual differences in data. 

 

NOAAS Ferdinand Hassler: P. Debroisse, J. Miller 



These stats were created using the Pydro BSB Surface ASCII Export Stats tool. As is seen, 95% of all nodes in the 2 meter 
difference surface are +/-0.01 meters.   

2m Difference Surface 



These stats were created using the Pydro BSB Surface ASCII Export Stats tool. As is seen, 95% of all nodes in the 4 meter 
difference surface are +/-0.01 meters.   

4m Difference Surface 



• In the 2m difference surface, 5 nodes had a difference 
greater than 1m with a max differences of -8.2m and 
3.1m. All of these larger differences occurred over 
features. The 8.2m difference occurred where one 
surface’s node referenced the feature and the other 
surface’s node referenced the seafloor immediately next 
to the feature. 

• In the 4m difference surface 44 nodes had a difference 
0.5m or greater with a max difference of -0.7m and 0.6m. 

• A review of all non-zero difference nodes indicated the 
apparent vertical difference was in fact due to horizontal 
differences in surface node structure. 

• Subset evaluations indicated typical vertical differences 
between SV processing methods of 1cm or less. 



Wreck 1 

Wreck 2 

2m difference surface and locations of large differences.  Wreck 1 max difference: 3.1m. Wreck 
2: max difference 8.2m. 



Old/New surfaces in Subset Editor 

Without SVC after SBETS With SVC after SBETS 



The -8.2m differenced node 



Without SVC after SBET 

With SVC after SBET 



Without SVC after SBET 

With SVC after SBET 



Without SVC after SBET 

With SVC after SBET 



An example of sounding difference over a wreck. Green is with re-SVC, Red is old. Note 
that a query of soundings that appear isolated showed that they are co-located with  
soundings of the opposite color.  
 



An example of sounding difference over a flat surface. Green is with re-SVC, Red is old. 
Note that a query of soundings that appear isolated showed that they are co-located 
with  soundings of the opposite color.  



An example of sounding difference over a steep slope. Green is with re-SVC, Red is old. 
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Final report 
 

SURVEY REPORT 
 
SHIP: M286 SWATH 
FERDINAND R. HASSLER 
 
LOCATION:  PASCAGOULA, MS 
 
DATE:  7/18-7/26, 2009 
And          11/4, 2009 
 
 
PURPOSE: 
   Determine the ship’s centerline, roll, and pitch. Install benchmarks,  install the master 
reference plane in the same planes as the measured roll, pitch, and azimuth of the ship. Assist the 
shipyard to install the IMUs parallel to the centerline, and in the same plane as the ship’s roll and 
pitch. Assist the shipyard in installing the transducers in the same plane as roll, pitch and azimuth 
of the ship. Measure and spot the draft marks. 
 
PERSONNEL:   
    Eric Kostelak 
    Brian Kloter 
    Raymond Impastado 
    John Miskimmin 
     
            
 
EQUIPMENT LIST: 
      WILD T2 THEODOLITE  SN:  169786  Calibration Expiration Date; 12/19/09 
         
 
       WILD T2 THEODOLITE  SN:  155062  Calibration Expiration Date; 12/19/09 
 
       WYLER CLINO 2000 CLINOMETER  SN: M4416  Calibration Expiration 
                                                                                                         Date; 07/10/10                                                    
                                                                                                      
       TOPCON GTS-301 One Second Electronic Total Station, Serial number GU1193 
                                                                          Calibration Expiration Date; 07/12/09 
 
       WILD NA1 AUTO LEVEL: SN 472810   Calibration Expiration Date; 07/12/09 
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Procedures: 
 
       1.  Establish a baseline in relation to the centerline of both pontoons. 
               A. Locate points on each of the pontoons to determine centerline 
               B. Measure the elevation differences of the points. Take the average of  
                    these to determine the pitch and roll of each pontoon. 
                     
       2.  Take the average of the measurements of the two pontoons for roll, pitch, 
             and centerline. The result can then be used as the Master reference.  
 
       3.  Create a traverse, in a level plane, around the ship using the established 
             baseline as a reference. Set various points that will be used to locate the 
             master reference block, IMUs, bench marks, transducers, and antennas. 
 
       4.  Locate, set and secure the master reference block to within 9 arc seconds 
            of the calculated roll, pitch, and centerline values. 
 
      5. Once the MRB has set for a day, confirm the measurements relative to the  
            results of step 2. If the measurements are within the two values used in  
            Step 2, these values will become the Final Master Reference, which all  
            further measurements will be referenced to. 
 
       6.  Locate IMU foundations, adjust to be level with roll and pitch, and aligned 
            with centerline. 
 
      7.  Establish bench marks that are aligned to the centerline in any areas that require  
           future measurements. 
 
       8. For transducers, on the bottom of the hull, establish punch marks aligned to the  
           centerline that can be used to align the transducers to the centerline. 
 
      9.  Run a closed level loop from the master reference block to all bench marks, 
           Transducers, antennas, and sensors to determine their elevation values 
            relative to the reference. (Z axis). 
 
     10. Using established elevation points within the traverse, determine the correct  
            locations for all draft marks. 
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     11. Work with the shipyard to determine the correct alignment of the transducers. 
 
METHODS 
    
          All angles at intersections were turned 4 times, 2 in regular, and 2 in inverted 
          position. All other angles were turned 2 times, once in regular, and once in  
          inverted position.  
 
           
 
          Slope distances were measured with a zenith angle in the regular and inverted  
          Position. 
 
           The Traverse was closed and computed for accuracy. 
 
 

Results 
 

MRB 
After the MRB has set up for 24 hours, it was found the chock fast had caused an 18 second 
movement in roll. As this small value was well within the average of the two pontoons, the final 
reference was shifted to the MRB values. 
 
IMU 
During measurements of the IMUs, we discovered it was impossible to meet the specification to 
be level to the roll and pitch within 90 arc seconds using the existing mounts. The shipyard 
manufactured a double plate separated by three threaded rods, which allowed fine 
adjustment in two planes (roll and pitch). The IMUs were aligned to zero measurable 
azimuth error, and to within 5 arc seconds in roll and pitch relative to the MRB. 
 
TRANSDUCERS 
7125 
 During measurements it became apparent that it was impossible to meet the roll and pitch 
specification on the multibeam transducer mounts. There was no measurable azimuth error on 
either 7125 transducer mount, when the welding was finished. The shipyard came up with the 
roll and pitch solution of machining the surfaces in place once the mounting plates were 
completely welded out. We attended for the machine work on 8/19/09. A portable milling 
machine was put in place, leveled to within 5 arc seconds of the MRB plus 4.5 degrees of roll to  
Give the transducer mounting surfaces the specified 4.5 degree outward roll angle. See attached 
photo. It was agreed by all that if the milling machine was positioned correctly, the surfaces had 
to be correct, but as a check to confirm the process, we measured the machined surface on the 
port unit, and found the pitch error was zero, and the roll error was 15 seconds. This was well 
within the required 90 seconds. 
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Milling machine set up on 7125 transducer housing 

 
 
 
 
7111 
 
Like the 7125s, it was impossible to meet the roll and pitch specification on this transducer 
mounting plate. It too, was machined by the portable milling machine. 
The machine was set up to be within 5 seconds of the MRB Pitch and Roll values. 
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                              XYZ COORDINATES TABLE 
 

POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 
5 9.264 -7.555 7.169 POINT FP 
6 9.409 6.256 7.168 POINT FS 
7 3.491 -7.478 7.176 POINT MP 
8 3.872 6.168 7.178 POINT MS 
9 -4.035 -7.561 7.168 POINT AP 

10 -4.022 6.258 7.169 POINT AS 
15 9.326 -0.652 7.168 CENTERLINE 
18 -4.017 -0.652 7.168 CENTERLINE 
19 16.343 2.530 -5.065 STARBOARD BENCH MARK TOP WHEEL HOUSE 
20 16.343 -0.653 -5.064 MID BENCH MARK TOP WHEEL HOUSE 
21 16.343 -3.836 -5.066 PORT BENCH MARK TOP WHEEL HOUSE 
25 -1.336 0.001 0.160 AFT BENCH MARK MASTER REFERENCE PLATE 
26 0.000 0.000 0.000 MASTER REFERENCE PLATE 
27 -0.353 0.000 0.161 FWD BENCH MARK MASTER REFERENCE PLATE 
28 13.428 -8.960 -2.496 PORT BENCH MARK BRIDGE WING 
29 13.428 -5.592 -2.476 STARBOARD BENCH MARK BRIDGE WING 
30 7.115 5.836 7.154 FWD PUNCH MARK ADCP 
31 5.765 5.835 7.145 AFT PUNCH MARK ADCP 
33 7.841 6.846 7.167 FWD PUNCH MARK RESON 7125 STARBOARD PONTOON 
34 5.025 6.847 7.168 AFT PUNCH MARK RESON 7125 STARBOARD PONTOON 
36 5.022 -8.169 7.157 AFT PUNCH MARK RESON 7125 PORT PONTOON 
37 7.792 -8.169 7.154 FWD PUNCH MARK RESON 7125 PORT PONTOON 
39 15.307 6.610 6.843 AFT PUNCH MARK RESON 7111 
40 16.098 6.611 6.771 FWD PUNCH MARK RESON 7111 
41 10.822 5.864 7.169 FWD PUNCH MARK MDS* STARBOARD PONTOON 
42 9.818 5.863 7.172 AFT PUNCH MARK MDS* STARBOARD PONTOON 
43 10.608 -7.081 7.177 FWD PUNCH MARK MDS* PORT PONTOON 
44 9.762 -7.080 7.175 AFT PUNCH MARK MDS* PORT PONTOON 
45 -13.926 -0.615 0.105 AFT MID BENCH MARK BACK DECK 
46 -9.031 -0.615 0.125 FWD BENCH MARK BACK DECK 
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POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 

47 -13.926 6.471 0.114 STARBOARD BENCH MARK BACK DECK 
48 -13.926 -7.697 0.093 PORT BENCH MARK BACK DECK 
51 5.891 -6.878 5.839 IMU PORT PONTOON (OLD LOCATION) 
52 5.923 5.428 5.840 IMU STARBOARD PONTOON (OLD LOCATION) 
53 17.655 6.584 6.890 RESON 7111 CENTER OF PLATE 
54 6.265 6.774 7.095 PORT EDGE RESON 7125 STARBOARD PONTOON 
55 6.265 6.805 7.093 RESON 7125 STARBOARD PONTOON 
56 6.223 -8.078 7.087 STARBOARD EDGE RESON 7125 PORT PONTOON 
57 6.223 -8.109 7.085 RESON 7125 PORT PONTOON 
58 16.039 5.417 2.563 INBOARD DRAFT MARK FRAME 4 STARBOARD 
59 16.025 -6.711 2.567 INBOARD DRAFT MARK FRAME 4 PORT 
60 -11.204 5.626 2.588 INBOARD DRAFT MARK FRAME 46 STARBOARD 
61 -11.208 -6.870 2.562 INBOARD DRAFT MARK FRAME 46 PORT 
62 16.040 7.458 2.565 OUTBOARD DRAFT MARK FRAME 4 STARBOARD 
63 -11.208 7.462 2.588 OUTBOARD DRAFT MARK FRAME 46 STARBOARD 
64 16.025 -8.735 2.570 OUTBOARD DRAFT MARK FRAME 4 PORT 
65 -11.205 -8.711 2.555 OUTBOARD DRAFT MARK FRAME 46 PORT 
66 6.273 -9.907 5.789 PORT BENCH MARK IMU PORT PONTOON 
67 6.273 -5.007 5.861 STARBOARD BENCH MARK IMU PORT PONTOON 
68 6.624 3.666 5.862 PORT BENCH MARK IMU STARBOARD PONTOON 
69 6.624 8.571 5.798 STARBOARD BENCH MARK IMU STARBOARD PONTOON 
70 5.861 -6.865 5.767 IMU PORT PONTOON 
71 5.885 5.381 5.768 IMU STARBOARD PONTOON 
72 -20.247 -0.609 -4.327 BOTTOM OF CENTER BLOCK "A" FRAME 
73 11.205 -1.904 -7.782 BOTTOM OF GPS ANTENNAE PORT LOWER 
74 10.488 -1.896 -9.774 BOTTOM OF GPS ANTENNAE PORT UPPER 
75 11.180 0.594 -7.776 BOTTOM OF GPS ANTENNAE STARBOARD LOWER 
76 10.455 0.589 -9.776 BOTTOM OF GPS ANTENNAE STARBOARD UPPER 
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NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 
PURPOSE 
 
The intention of this survey was to accurately position the relocated POS Antennas 
and Side Scan Sonar tow point. 
 
PROJECT DETAILS 
 
This survey was conducted on March 29, 2011 on Spring River Island in 
Pascagoula, MS.  NGS was provided data from a previous survey that contained a 
complete point listing of all components as well as recoverable bench mark 
stations.  The NOAA Ferdinand Hassler was in water causing some instability of 
the instrument and target reflectors.  The tilt compensator had to be bypassed in 
order to take measurements.       
 
INSTRUMENTATION 
 
The TOPCON GPT 3000 Series Total Station was used to make all measurements. 

A SECO 25 mm Mini Prism System configured to have a zero mm offset was used 
as target sighting and distance measurements. 

SOFTWARE AND DATA COLLECTION 

TDS Survey Pro Ver. 4.7.1 

ForeSight DXM Ver. 3.2.2 was used for post processing.  

PERSONNEL 

Kevin Jordan NOAA/NOS/NGS/Field Operations Branch 757-441-5478 

Doug Adams NOAA/NOS/NGS/Field Operations Branch 757-441-5480 

 

 
 
 
 
 



NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 

SURVEY PROCEDURES 
 
RECOVERED STATIONS 
 
MID BENCH MARK TOP WHEEL HOUSE 

 
 
PORT BENCH MARK TOP WHEEL HOUSE 

 
 
STARBOARD BENCH MARK TOP WHEEL HOUSE 



 
 
AFT MID BENCH MARK BACK DECK 

 
 
PORT BENCH MARK BACK DECK 



 
 
STARBOARD BENCH MARK BACK DECK 

 
 
 



PORT BENCH MARK BRIDGE WING 
-NO PHOTOS OF THIS STATION 
 
NEW FEATURES 
 
PORT POS ANTENNA MOUNT 

 
 
 



STARBOARD POS ANTENNA MOUNT 

 
 
 
 
 
 



SIDE SCAN SONAR TOW POINT 
-Horizontal Survey Point (HSP) 
-Vertical Survey Point (VSP) 

 
 
 

 



Setup #1 
Using the coordinates from the previous survey, the field crew setup the theodolite 
on the MID BENCH MARK TOP WHEEL HOUSE and initialized on PORT 
BENCH MARK BRIDGE WING to obtain a starting azimuth.  From this setup, we 
collected the four POS antenna mount locations:  

PORT FWD ANTENNA 
PORT AFT ANTENNA 
STARBOARD FWD ANTENNA 
STARBOARD AFT ANTENNA 

 
Positional checks were made to bench mark stations (see attached comparison 
report): 

PORT BENCH MARK TOP WHEEL HOUSE 
STARBOARD BENCH MARK TOP WHEEL HOUSE 
PORT BENCH MARK BRIDGE WING 
 

A temporary point (TP1) was established on the flying bridge near the stairs in 
order to collect the location of the SIDE SCAN SONAR TOW POINT. 
 
Setup #2 
The field crew setup on TP1 and initialized on the MID BENCH MARK TOP 
WHEEL HOUSE.  From this setup, we collected: 

SIDE SCAN SONAR TOW POINT 
 

Positional checks were made to bench mark stations (see attached comparison 
report): 

MID BENCH MARK TOP WHEEL HOUSE  
AFT MID BENCH MARK BACK DECK 
 

Setup #3 
The field crew setup on AFT MID BENCH MARK BACK DECK and initialized 
on TP1.  Positional checks were made to bench mark stations (see attached 
comparison report): 

PORT BENCH MARK BACK DECK 
STARBOARD BENCH MARK BACK DECK 

 
 
 
 
 
 
 



DISCUSSION 
All sensor/benchmark coordinates are contained in spreadsheets “NOAA SHIP 
HASSLER.xls”   
 
The following table includes stations that were observed from more than 
one setup and for each, an inverse was computed to identify possible 
setup errors.  Each station checked with favorable results. 
 

OBSERVED to PUBLISHED COMPARISON (Units in Meters) 
NAME ∆ Northing  ∆ Easting  ∆ Elevation  

PORT BENCH MARK 
BRIDGE WING -0.003 -0.008 0 
PORT BENCH MARK 
TOP WHEEL HOUSE 0.030 -0.015 -0.003 
STARBOARD BENCH 
MARK TOP WHEEL 
HOUSE -0.026 0.010 -0.006 
MID BENCH MARK 
TOP WHEEL HOUSE 0.015 0.002 -0.007 
AFT MID BENCH 
MARK BACK DECK -0.020 -0.030 0.011 
PORT BENCH MARK 
BACK DECK 0.027 -0.002 -0.005 
STARBOARD BENCH 
MARK BACK DECK -0.015 0.018 -0.011 

 



NEW GPS IMU ‐ NGS 2012

IMU PORT

DESCRIPTION X Y Z

STAR FWD ANT 2.722 9.162 ‐12.869

STAR AFT ANT 0.719 9.159 ‐12.895

PORT FWD ANT 2.712 1.05 ‐12.838

PORT AFT ANT 0.706 1.052 ‐12.853

STARBOARD BM TOP OF WHEEL HOUSE 10.482 9.395 ‐10.832

PORT BM TOP OF WHEEL HOUSE 10.482 3.034 ‐10.807

IMU STBD

DESCRIPTION X Y Z

STAR FWD ANT 2.698 ‐3.084 ‐12.87

STAR AFT ANT 0.695 ‐3.087 ‐12.896

PORT FWD ANT 2.688 ‐11.196 ‐12.839

PORT AFT ANT 0.682 ‐11.194 ‐12.854

STARBOARD BM TOP OF WHEEL HOUSE 10.458 ‐2.851 ‐10.833

PORT BM TOP OF WHEEL HOUSE 10.458 ‐9.212 ‐10.808
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PURPOSE 

During the 2012 field season it was discovered that previously determined offsets from the original ship 
survey (Impastato, 2009) were in need of refinements.  Results from 2012 post‐processed POSPac 
derived offset solutions and ellipsoidally referenced leadline (ERLL) measurements showed a difference 
of approximately 20 centimeters in the vertical direction.  This error was floating somewhere between 
the navigation GPS antennas, IMU and transducers.  An attempt to track down this error was performed 
by Ferdinand R. Hassler personnel during the drydock period (April 2013) at Colonna’s Shipyard in 
Norfolk, VA. 

METHODS 

A calibrated optical level was utilized to obtain a closed loop of elevations on important points and 
sensors around the ship.  These elevations are with respect to gravity, in order to transform them to the 
ship’s reference frame (SRF) an additional loop was obtained containing known benchmark elevations.  
From these benchmark elevations, values for pitch and roll were computed. 

The primary sensor loop contained elevations from the starboard forward (primary) POS antenna on the 
flying bridge to a temporary benchmark (TBM) located on the drydock floor.  From the TBM the loop 
proceeded to close by way of the port forward POS antenna and a final closing shot between the two 
antennas.  This resulted in a closed loop with less than 5 millimeters of calculated misclosure. 

The TBM on the drydock floor was utilized for spurs to survey sensors.  Each individual sensor was 
treated separately and closed with a misclosure computed in the calculation spreadsheet.  Both IMU’s 
was measured using a level and tape measure from known point via the cable route (7125’s and cables 
were removed for shipyard period).  The 7125 elevations were computed from the averaged elevation 
readings on the inboard and outboard base of frame, accounting for the manufactured 4.5 degree tilt. 

A total station was utilized to obtain elevations on all eight draft marks permanently fixed on the ship’s 
hull.  A reflectorless (laser) measurement device measured the vertical distance relative to a level 
gravimetric plane of the instrument.  

To obtain results a couple of points were assumed: 

1) The ship reference frame is accurately documented and defined from the Impastato ship survey.  
From the established benchmarks we are able to recreate the ship reference frame and apply 
pitch/roll calculations correctly. 

2) Coordinates provided from Impastato are correct until proven otherwise.  We use distances 
from the master reference block (MRB) for applying the pitch/roll offsets but strongly disagree 
with many of his z‐coordinates.  Also, along with #1; benchmarks utilized were crucial in 
recreating the ships reference frame. 

3) Distances from the MRB for applying pitch/roll offsets is close enough to the center of gravity 
for the vessel to accurately apply pitch and roll. 
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4) The Hassler is located in a floating drydock which is subject to outside influences (e.g. tide, 
current, wind).  However, the influences will affect both drydock and ship at the same rate and 
therefore be negligible. 

RESULTS 

Ship Reference Frame: 

One of the primary issues with surveying a ship is orientating results obtained via outside reference 
frames (e.g gravity) into the SRF.  During the Impastato ship survey, the surveyor defined the ship’s 
master reference frame by measuring the pitch and roll of each pontoon and averaging these values.  
From this point he established various benchmarks located around the vessel; including the MRB, IMU 
plates, transducers and antennas.  It is from this original survey benchmarks that enable us to transform 
coordinates relative to the SRF. 

A level loop was run from a benchmark established by FH personnel on the bow of the Hassler to two 
benchmarks established by Impastato on the aft corners.  From these three benchmarks we figured the 
difference of design slope to actual slope for both pitch and roll.  The correction was corrected with the 
distance from the MRB, which is near but not located at the center of gravity (motion) for the vessel.  
This appears to be the same strategy utilized by Impastato during the original survey.   

Ship Sensors: 

Through careful analysis of the main level loop and the spurs to each individual sensor located on the 
pontoons, the following offsets were obtained. 

Sensor 
Corrected height from 

Antenna Base 
Corrected height from  

IMU 
Port IMU (base of plate)  ‐12.990  Port  ‐‐  ‐‐ 

Starboard IMU (base of plate)  ‐12.990  Starboard  ‐‐  ‐‐ 
7125 Port (middle Rx)  ‐14.203  Port  ‐1.213  Port 

7125 Starboard (middle Rx)  ‐14.212  Starboard  ‐1.222  Starboard 
7111 (middle Rx)  ‐14.149  Starboard  ‐1.159  Starboard 

Port VBES  ‐14.236  Starboard  ‐1.245  Starboard 
Starboard VBES  ‐14.237  Starboard  ‐1.247  Starboard 

Table 1: 2013 Sensor Offset Results 

Comparisons were made from the 2013 sensor offset results with offsets used previously during the 
2012 season.   Two sets of z‐offsets were used during the 2012 season; those obtained through 
Impastato ship survey coordinates and those obtained through post‐processed POSPac results 
(supported through ERLL results).  The results of the delta Z values (2013 minus 2012) are shown below 
in Table 2. 
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Sensor 
Delta Z (m) 
(Impastato) 

Delta Z (m) 
(Revised) 

Notes and Analysis 

Stbd IMU ‐> 
Stbd APC 

0.225  ‐0.002 
Revised measurements from POSPac and ERLL; 2013 
survey values strongly agree with revised results. 

Port IMU ‐> 
Port APC 

0.212  ‐0.019 
Revised measurements from POSPac; 2013 survey values 
strongly agree with revised results. 

Stbd IMU ‐> 
7111 Rx 

‐0.171  n/a 
No revisions were made between the Stbd IMU and 7111 
Rx. 

Stbd APC ‐> 
7111 Rx 

0.176  n/a 
No revisions were made between the Stbd APC and 7111 
Rx. 

Stbd IMU ‐> 
7125S Rx 

‐0.103  ‐0.011 
Revised measurements were never used; 2013 survey 
values show disagreement between IMU and sensor. 

Stbd APC ‐> 
7125S Rx 

0.244  ‐0.105 
Revised measurements from POSPac and ERLL; 2013 
survey values show same disagreement between IMU and 
sensor. 

Port IMU ‐> 
7125P Rx 

‐0.105  0.011 
Revised measurements were never used; 2013 survey 
values show disagreement between IMU and sensor. 

Port APC ‐> 
7125P Rx 

0.229  ‐0.123 
Revised measurements from POSPac; 2013 survey values 
show same disagreement between IMU and sensor. 

Table 2: Delta Values between 2013 and 2012 

 Draft Marks: 

Field elevation measurements were corrected using the same pitch and roll constants as stated earlier.  
For this calculation the X/Y locations of the draft marks were obtained from Impastato ship survey. 

Forward Port 
Outboard 

Forward Port 
Inboard 

Forward Stbd 
Inboard 

Forward Stbd 
Outboard 

2.57  2.58  2.52  2.52 
2.77  2.78  2.71  2.71 
2.97  2.98  2.92  2.91 
3.16  3.18  3.12  3.11 
3.37  3.38  3.32  3.30 
3.57  3.58  3.52  3.51 
3.77  3.78  3.71  3.71 
3.97  3.98  3.92  3.91 
4.17  4.18  4.12  4.11 
4.37  4.38  4.32  4.31 
4.57  4.58  4.52  4.51 
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After Port 
Outboard 

After Port 
Inboard 

After Stbd 
Inboard 

After Stbd 
Outboard 

2.58  2.58  2.61  2.59 
2.78  2.77  2.81  2.80 
3.99  2.97  3.01  2.99 
3.18  3.17  3.21  3.20 
3.38  3.37  3.41  3.40 
3.58  3.57  3.61  3.60 
3.79  3.78  3.81  3.80 
3.98  3.98  4.01  4.00 
4.18  4.18  4.21  4.20 
4.38  4.38  4.41  4.40 
4.58  4.58  4.61  4.60 

Table 3: Draft Mark Elevations relative from MRB (z is positive down) 

Ship Traverse: 

While in our possession the total station instrument was utilized for a ship traverse of existing 
benchmarks and POS antennas; as well as recreating the original SRF from the Impastato survey.  
Methods for this traverse were not as complete as was desired due to inadequate equipment and 
training of personnel.  However, the calculations serve as additional checks against prior surveys and 
because an X/Y position was established on the TBM, help tie all previously discussed methods into a 
complete survey.  More calculations are required on these acquired data once defined goals are 
obtained. 

CONCLUSIONS 

Vertical offsets from the level loop agree closely with offsets derived from post‐processed POSPac 
solutions and ERLL calculations resulting in more confidence of both these methods.  Hours were spent 
overlooking Impastato’s original survey notes for any indication of possible errors or blunders but none 
were found.  From these results it is safe to say that there were errors and possibly an overall 
miscommunication of exact reference points for measurement.  Ferdinand R. Hassler’s 2013 offsets will 
be defined from an in‐depth analysis of these results and subsequent ERLL and reference surfaces to be 
acquired during Hydrographic Systems Readiness Review 2013. 

Draft marks appear to near locations defined by Impastato as well as being generally level with respect 
to the ship reference frame; however, it appears that there is a disagreement with the forward 
starboard draft marks.  



Offsets: POS MV
Measurement

Coord. Sys. Caris POSMV Caris POSMV Caris POSMV Caris POSMV (from calc) (from calc)
x 1.002 2.713 ‐3.104 2.700 NA NA NA NA Scaler Distance 2.000 Scaler Distance 2.006
y 2.713 1.002 2.700 ‐3.104 NA NA NA NA
z ‐12.920 ‐12.920 ‐12.920 ‐12.920 NA NA NA NA

(from GAMS Cal) (from GAMS Cal)
Scaler Distance Scaler Distance

Calculations

x 0.000 x 0.000 Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant Port y 6.123
y 0.000 y 0.000 (from 2013 calculations) (from 2013 calculations) STBD y ‐6.123
z 0.1236 z 0.1236 x 2.713 x 2.700

(in POSMV) (in POSMV) y 1.002 y ‐3.104 x and z zero
z ‐12.920 z ‐12.920

x 0.000 x 0.000
y 0.000 y 0.000 Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant
z 0.012 z 0.012 (from PosPac calibration) (from PosPac calibration)

(in POSMV) (in POSMV) average average
x x

x 2.713 x 2.700 y y
y 1.002 y ‐3.104 z z
z ‐12.990 z ‐12.990 *calculated averages between multiple days

(in POSMV) (in POSMV)

x 0.000 x 0.000 Ref to Center of Rotation
y 0.000 y 0.000 (Top of Stbd IMU to Center of Rotation)
z ‐0.066 z ‐0.066 POSMV

(in POSMV) (in POSMV) ‐3.705
‐6.033
‐2.270

x 2.713 x 2.700 (from waterline )
y 1.002 y ‐3.104 Added to Pos on DN285 2012
z ‐12.920 z ‐12.920

(in POSMV) (in POSMV)

Top of Port IMU to Fwd Port Ant Top of Stbd IMU to Fwd Stbd Ant

Top of Port IMU 
to aft port ant 
phase center

Top of Stbd 
IMU to fwd port 

ant phase 
center

Adapter Plate 

from physical measurement

Adapter Plate

from physical measurement

(x/y from 2012 POSPac, z from 
FH 2013 drydock 
measurements)

(x/y from 2012 POSPac, z from 
FH 2013 drydock 
measurements)

Antenna base 
to phase 
center

Antenna base 
to phase 
center

(from Trimble diagram) (from Trimble diagram)

Adapter Plate  
to top of IMU

Adapter Plate  
to top of IMU

(from POSMV V5 User Guide) (from POSMV V5 User Guide)

Center of Port 
IMU Plate to 

Fwd Port 
Antenna Base

Center of Stbd 
IMU Plate to 

Fwd Stbd 
Antenna Base

Stbd Ant Seperation Port Ant Seperation

POSMV offsets are derived from measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant PosPac Derived Offsets

Port Ant SeperationPort IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant Stbd IMU to Heave Stbd IMU to Heave Stbd Ant Seperation



Offsets: Port 7125

Measurement
Coord. Sys. Caris Caris Reson Hypack

x -1.244 -2.246 0.000 Stbd -1.244
y 0.362 -2.351 -0.441 Fwd 0.362
z 1.349 14.269 0.047 Vertical 3.780

TILTED 4.5 degrees up to port TILTED 4.5 degrees up to port
*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x -1.002 x 0.000 x -1.244

y 0.000 y -2.713 y 0.000 y 0.362

z 0.1356 z 12.920 z 0.000 z 1.349
(in CARIS) (in CARIS) (in Reson) (in CARIS)

x -1.244 x -1.244 x 0.000 x 0.000

y 0.362 y 0.362 y 0.441 y 0.000
z 1.213 z 1.349 z -0.047 z 2.431

(in CARIS) (in CARIS) (in Reson) (in Hypack)

x -1.244 x -2.246 x 0.000 x -1.244
y 0.362 y -2.351 y -0.441 y 0.362

z 1.349 z 14.269 z 0.047 z 3.780
(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*
Z calc includes 0.015 m from base to RP 0.102 from Reson diagram - Rx width

Impastato X/Y measurement locations unknown 0.25 from 2013 drydock - Gap between Rx and Tx

0.28 from Reson diagram - Tx length

0.003656 4.5° tilt calculated from Tx diameter
0.046456 4.5° tilt calculated from Tx diameter

Reson Projector to Receiver

(from Reson diagram, entered in 
Reson Hardware configuration)

Waterline to Stbd 7125 RP

Port IMU to 
Port 7125

Waterline to Stbd 7125 RP
Port IMU RP 
to Port 7125 

RP

Top Port IMU 
to Waterline

(from waterline spreadsheet)

(Hypack vertical is positive down 
from waterline.)

(from calculations)

Port IMU to Port 7125 Fwd Port Ant to Port 7125 RP

Port IMU 
Plate to Port 

7125 

Port IMU RP to 
Port 7125 

Projector to Receiver 

(from POSMV V5 User 
Guide)

Top of IMU to 
center of IMU 

Plate

Antenna Phase 
Center to IMU 

Ref Pt

(x/y from Impastato, Z 
from 2013 drydock)*

(x/y from Impastato, Z from 
2013 drydock)

(from POS MV calculation 
tab)

Reson Projector to Receiver

Tx RP

(from Reson diagram)

Rx RP

(from Reson diagram and  
2013 drydock)

Hysweep Offsets

Port IMU to Port 7125 Fwd Port Ant to Port 7125

Port IMU to Port 7125 (MRU to 
Trans)

Fwd Port Ant to Port 7125 (Nav to 
Trans)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.



Offsets: Starboard 7125

Measurement
Coord. Sys. Caris Caris Reson Hypack

x 1.424 4.528 0.000 Stbd 1.424
y 0.380 -2.320 -0.437 Fwd 0.380
z 1.358 14.278 0.047 Vertical 3.789

TILTED 4.5 degrees up to stbd TILTED 4.5 degrees up to stbd
*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x 3.104 x 0.000 x 1.424

y 0.000 y -2.700 y 0.000 y 0.380
z 0.1356 z 12.920 z 0.000 z 1.358

(in CARIS) (in CARIS) (in Reson) (in CARIS)

x 1.424 x 1.424 x 0.000 x 0.000

y 0.380 y 0.380 y 0.437 y 0.000

z 1.222 z 1.358 z -0.047 z 2.431
(in CARIS) (in CARIS) (in Reson) (in Hypack)

x 1.424 x 4.528 x 0.000 x 1.424

y 0.380 y -2.320 y -0.437 y 0.380
z 1.358 z 14.278 z 0.047 z 3.789

(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*
Z calc includes 0.015 m from base to RP 0.102 from Reson diagram - Rx width

Impastato X/Y measurement locations unknown 0.246 from 2013 drydock - Gap between Rx and Tx

0.28 from Reson diagram - Tx length

0.003656 4.5° tilt calculated from Tx diameter
0.046456 4.5° tilt calculated from Tx diameter

(from Reson diagram and  
2013 drydock)*

Reson Projector to Receiver Waterline to Stbd 7125 RP

Hysweep OffsetsReson Projector to Receiver 

(from Reson diagram, entered in 
Reson Hardware configuration)

Stbd IMU to 
Stbd 7125

Stbd IMU RP to 
Stbd 7125 

Stbd IMU to Stbd 7125 RP Fwd Stbd Ant to Stbd 7125 RP

Stbd IMU to Stbd 7125 Fwd Stbd Ant to Stbd 7125

IMU Plate to 
Stbd 7125 

Antenna Phase 
Center to IMU 

Ref Pt

Top of IMU 
to Center of 
IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU to Stbd 7125 (MRU to 
Trans)

Fwd Stbd Ant to Stbd 7125 (Nav to 
Trans)

Top Stbd 
IMU to 

Waterline

(from waterline spreadsheet)

(Hypack vertical is positive down from 
waterline.)

Waterline to Stbd 7125 RP
Stbd IMU RP 
to Stbd 7125 

RP

(x/y from Impastato, Z from 
2013 drydock)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

(x/y from Impastato, Z 
from 2013 drydock)*

(from POS MV calculation 
tab)

(from calculations)

Reson Projector to Receiver

Tx RP

(from Reson diagram)

Rx RP



Offsets: Starboard 7111
Measurement

Coord. Sys. Caris Caris Reson Hypack

x 1.203 4.307 0.000 Stbd 1.203

y 11.608 8.908 -0.499 Fwd 11.608

z 0.977 13.897 -0.269 Vertical 3.408

*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x 3.104 x 0.000 x 1.203

y 0.000 y -2.700 y 0.000 y 11.608

z 0.1356 z 12.920 z 0.000 z 0.977
(in CARIS) (in CARIS) (in Reson) (in CARIS)

x 1.203 x 1.203 x 0.000 x 0.000

y 12.107 y 11.608 y 0.499 y 0.000

z 1.159 z 0.977 z 0.269 z 2.431
(in CARIS) (in CARIS) (in Reson) (in Hypack)

x 0.000

y -0.499

z -0.318
(in CARIS)

x 1.203 x 4.307 x 0.000 x 1.203

y 11.608 y 8.908 y -0.499 y 11.608

z 0.977 z 13.897 z -0.269 z 3.408
(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*

1.203 from Impastato ‐ CL IMU to CL Plate 0.098 from Reson diagram - Tx diameter

11.77 from Impastato ‐ CL IMU to CL Plate

0.05341 from Reson diagram ‐ CL Plate to Mounting Bolt

0.434 from Reson diagram ‐ Mounting Bolt to aft Tx

0.65 from Reson diagram ‐ Tx overall length

0.125 from 2013 drydock ‐ Gap between Tx and Rx

0.0982 from Reson diagram ‐ Rx thickness

Sanity Check Physical measurement = 11.150 +/- 20 cm

calc measurement = 11.228

diff = -0.078

Reson Projector to Receiver

(from Reson diagram and 
2013 drydock)*

Waterline to 7111 RP

IMU RP to 7111 
Acoustic RP

(from calculations)(from Reson diagram)

Rx RP Top Stbd IMU to 
Waterline

(from waterline spreadsheet)

Top of Stbd IMU to 7111 RP Fwd Stbd Ant RP to 7111 RP

IMU Plate to 
7111 Rx Face

(from POS MV calculation tab)

7111 Rx Face to 
7111 Acoustic 

RP

(from Reson diagram)

(x/y from Impastato, Reson 
diagram and 2013 drydock, z 

from 2013 drydock)*

(x/y from Impastato and Reson 
diagram, z from 2013 drydock)

(from POSMV V5 User Guide)

IMU to 7111 (MRU to Trans) Fwd Stbd Ant to 7111 (Nav to Trans) Hysweep Offsets

Antenna Phase 
Center to IMU 

RP

Top Stbd IMU to 
7111 RP

Top of IMU to 
Center of IMU 

Plate

Waterline to 7111 RP

(Hypack vertical is positive down 
from waterline.)

Reson Projector to Receiver 

(from Reson diagram, entered in 
Reson Hardware configuration)

Tx RP

Reson Projector to Receiver

Stbd IMU to 
7111 RP

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

Stbd IMU to 7111 Fwd Stbd Ant to 7111 RP



Offsets: Dual 7125 (HSX only)

Measurement
Coord. Sys. Caris Caris Caris Caris Hypack Hypack

x -13.490 1.424 -10.386 4.528 Stbd -13.490 Stbd 1.424
y 0.338 0.380 -2.362 -2.320 Fwd 0.338 Fwd 0.380
z 1.314 1.358 14.234 14.278 Vertical 3.745 Vertical 3.789

*Top of Stbd IMU is RP (Reference Pt) TILTED 4.5 degrees up to port TILTED 4.5 degrees up to stbd
Tilted up 4.5 degrees up on both sides

Calculations

x 0.000 x 0.000 x 3.104 x 3.104 x -13.490 x 1.424

y 0.000 y 0.000 y -2.700 y -2.700 y 0.338 y 0.380
z 0.1356 z 0.1356 z 12.920 z 12.920 z 1.314 z 1.358

(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS)

x -12.246 x 1.424 x -13.490 x 1.424 x 0.000 x 0.000

y -0.024 y 0.380 y 0.338 y 0.380 y 0.000 y 0.000

z -0.035 z 1.222 z 1.314 z 1.358 z 2.431 z 2.431
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

x -1.244
y 0.362

z 1.213
(in CARIS)

x -13.490 x 1.424 x -10.386 x 4.528 x -13.490 x 1.424

y 0.338 y 0.380 y -2.362 y -2.320 y 0.338 y 0.380
z 1.314 z 1.358 z 14.234 z 14.278 z 3.745 z 3.789

(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

Note: For dual acquisition 7125, the HSX file contains data from both 7125s but only POSMV data from the stbd POSMV.  The port 7125 is swath 1 (beams 1-512) and the stbd 7125 is swath 2 (beams 513 to 1024).  

Fwd Stbd Ant to Stbd 7125 RPStbd IMU to Port 7125 RP Fwd Stbd Ant to Port 7125 RP

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Stbd 7125 RP

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 2013 
Drydock)

Port IMU Plate 
to Port 7125

(x/y from Impastato, Z from  2013 
Drydock)

(x/y from Impastato, Z from  2013 
Drydock)

(from POS MV calculation 
tab)

Fwd Stbd Ant 
to Stbd IMU RP

top of IMU 
toCenter of 

Stbd IMU Plate

(from POSMV V5 User Guide)

Stbd IMU Plate 
to Port IMU 

Plate 

Stbd IMU RP to 
Port 7125 

Fwd Stbd Ant 
to Stbd IMU RP

(from POS MV calculation 
tab)

Stbd IMU RP to 
Stbd 7125 

Stbd 7125 Hysweep Offsets

Stbd IMU to 
Stbd 7125

Waterline to Stbd 7125 RP
Top Stbd 

IMU to Stbd 
7125 RP

Top Stbd 
IMU to 

Waterline

(from calculcations)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

top of IMU to 
Center of IMU 

Plate 

(from POSMV V5 User Guide)

IMU Plate to 
Stbd 7125 

Fwd Stbd Ant to Stbd 7125 (Nav to 
Trans)

Fwd Stbd Ant to Stbd 7125

Stbd IMU to Port 7125 (MRU to Trans) -
Swath 1

(from waterline spreadsheet)

Waterline to Stbd 7125 RP

Top Stbd 
IMU to Port 

7125 RP

Top Stbd 
IMU to 

Waterline

(from waterline spreadsheet)

Waterline to Stbd 7125 RP

(from calculcations)

Stbd  IMU to Stbd 7125 (MRU to 
Trans) - Swath 2

Stbd IMU to Stbd 7125Stbd IMU to Port 7125 Fwd Stbd Ant to Port 7125 Waterline to Stbd 7125 RP

(Hypack vertical is positive down 
from waterline.)

Stbd IMU to 
Port 7125

Fwd Stbd Ant to Port 7125 (Nav to 
Trans) Port 7125 Hysweep Offsets



Offsets: ODOM Single Beam

Measurement

Coord. Sys. Caris Caris Caris Caris Hypack Hypack

x ‐0.455 ‐12.701 2.649 ‐9.597 Stbd -0.455 Stbd -12.701

y 4.620 4.620 1.920 1.920 Fwd 4.620 Fwd 4.620

z 1.383 1.381 14.303 14.301 Vertical 3.835 Vertical 3.861

(in CARIS) (in CARIS) TILTED 4.5 degrees up to port TILTED 4.5 degrees up to stbd

Calculations

x 0.000 x 0.000 x 3.104 x 3.104 x -0.455 x -12.701

y 0.000 y 0.000 y -2.700 y -2.700 y 4.620 y 4.620

z 0.1356 z 0.1356 z 12.920 z 12.920 z 1.383 z 1.381
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS)

x -0.455 x -12.701 x -0.455 x -12.701 x 0.000 x 0.000

y 4.620 y 4.620 y 4.620 y 4.620 y 0.000 y 0.000

z 1.247 z 1.245 z 1.383 z 1.381 z 2.431 z 2.431
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

x -0.455 x -12.701 x 2.649 x -9.597 x -0.455 x -12.701

y 4.620 y 4.620 y 1.920 y 1.920 y 4.620 y 4.620

z 1.383 z 1.381 z 14.303 z 14.301 z 3.835 z 3.861
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

Fwd Stbd Ant to Port 7125 RP Fwd Stbd Ant to Stbd 7125 RP

Fwd Stbd Ant to Stbd SB Fwd Stbd Ant to Port SB

Fwd Stbd 
Ant to Stbd 

IMU RP

Fwd Stbd 
Ant to Stbd 

IMU RP

(from POS MV calculation 
tab)

(from POS MV calculation 
tab)

Stbd IMU to 
Stbd SB 

Stbd IMU to 
Port SB

Fwd Stbd Ant to Stbd SB Fwd Stbd Ant to Port SB

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Port SB
top of IMU 

to Center of 
IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU 
Plate to Port 

SB

(x/y from Impastato, Z from 
2013 drydock)*

Stbd IMU to Stbd SB

top of IMU 
to Center of 

IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU 
Plate to 
Stbd SB 

(x/y from Impastato, Z from 
2013 drydock)*

Stbd IMU to Stbd SB

Stbd IMU to Stbd SB Stbd IMU to Port SB

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Stbd SB

Port 7125 Hysweep Offsets Stbd 7125 Hysweep Offsets

Stbd IMU to 
Stbd SB

Stbd IMU to 
Port SB

(Hypack vertical is positive down 
from waterline.)

Waterline to Stbd 7125 RP

Waterline to Port SB RP
Stbd IMU RP 

to Port SB 
RP

(from calculations)

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)

Waterline to Stbd 7125 RP

Waterline to Stbd SB RP
Stbd IMU RP 
to Stbd SB 

RP

(from calculations)

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)



Offsets: Klein 5000
Measurement

Coord. Sys. Caris

x 7.161
y ‐26.032
z ‐9.347

(in CARIS)

Port IMU to TowPoint
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PURPOSE 
 
The intention of this survey was to accurately position the POS/MV IMU, GPS 
Antennas, Sonar Equipment, bench marks, and reference marks located on the 
2702 Launch. 
 
PROJECT DETAILS 
 
This survey was conducted on June 16, 2015 at the Kittery Point Yacht Yard in 
Eliot, ME.  The launch was placed jack stands to stabilize the launch during the 
survey.   
 
INSTRUMENTATION 
 
The TOPCON GPT 3000 Series Theodolite was used to position all points on the 
launch. 

A SECO 25 mm Mini Prism System configured to have a zero mm offset was used 
as target sighting and distance measurements. 

SOFTWARE AND DATA COLLECTION 

TDS Survey Pro Ver. 4.7.1 

ForeSight DXM Ver. 3.2.2 was used for post processing.  

PERSONNEL 

Kevin Jordan NOAA/NOS/NGS/Field Operations Branch 757-441-3603 

Steve Atkins NOAA/NOS/NGS/Field Operations Branch 757-441-3603 

 

 
 
 
 

 
 
 
 
 



Temporary Control 
 
A network of temporary control was established at KPYY consisting or two marks 
set on the ground.  One mark was 10 meters behind the boat and the other was 13 
meters off the starboard side.   
 
OBSERVED POINTS 
 
AFT BENCHMARK 

 
 
 
 
 
 
 



PORT BENCHMARK 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



STARBOARD BENCHMARK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



FWD BENCHMARK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



IMU 

 
 
NOTE:   The four corners of the IMU were observed, but presented a challenge 
due to low overhead above the IMU and the rounded corners of the IMU.  The best 
attempt was made using a plumb bob and prism. 
 
Coordinates for these points are listed in the coordinate spreadsheet. 



 
 
TRANSMITTER 

 
 
RECEIVER 

 
 
 
 
 



STARBOARD GPS ARP (BOTTOM OF ANTENNA) 

 
 



PORT GPS ARP (BOTTOM OF ANTENNA) 

 
 



R I (REFERENCE MARK ONE) 

 
 
R II (REFERENCE MARK TWO) 

 
 
 
 
 
 
 



R III (REFERNCE MARK THREE) (NEAR IMU) 

 
 
R IV (REFERENCE MARK FOUR)  

 
 
 
 
 
 
 



PLUMB MARK OVER R IV 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



POST PROCESSING 
 
The collected points were referenced to Geodetic Coordinates and needed to be 
translated to reference the IMU as X=0, Y=0, Z=0.  The azimuth from AFT 
BENCHMARK to FWD BENCHMARK needed to be oriented to 0° 00’ 00” .  
Post Processing was performed using ForeSight DXM to produce the following 
Coordinate Report.  The X Axis is Positive toward the Bow.  The Y Axis is 
positive toward the Starboard side.  The Z Axis is positive downward. 
 
    
DESCRIPTION X (METERS) Y (METERS) Z (METERS) 
IMU 0.000 0.000 0.000 
BM AFT -4.526 -0.005 -0.588 
BM PORT -1.146 -1.168 -0.759 
BM STAR -1.138 1.148 -0.765 
PORT GPS ARP -0.524 -0.522 -2.525 
STAR GPS ARP -2.033 0.560 -2.499 
R I -0.431 0.091 0.469 
R II -0.910 0.097 0.481 
R III 0.191 -0.231 0.303 
R IV -1.268 -0.008 -2.040 
PLUMB TAPE ON DECK -1.260 -0.009 -0.112 
IMU AFT STAR -0.072 0.074 -0.002 
IMU AFT PORT -0.069 -0.076 -0.003 
IMU FWD PORT 0.053 -0.084 -0.007 
IMU FWD STAR 0.050 0.073 -0.007 
BM FWD 1.674 -0.005 -0.988 
TX -0.633 0.231 0.403 
RX -0.833 0.237 0.407 

 



2702 ‐ Multi‐Year Dynamic Draft Comparison

Speed 
(m/s)

2016‐063
Average 
2016‐
20XX

Std Dev

0.0 0.00 0.00 0.00
0.5 ‐0.02 ‐0.02 0.00
1.0 ‐0.02 ‐0.02 0.00
1.5 ‐0.01 ‐0.01 0.00
2.0 ‐0.01 ‐0.01 0.00
2.5 0.01 0.01 0.00
3.0 0.01 0.01 0.00
3.5 0.01 0.01 0.00
4.0 ‐0.01 ‐0.01 0.00
4.5 ‐0.04 ‐0.04 0.00
5.0 ‐0.08 ‐0.08 0.00
5.5 ‐0.14 ‐0.14 0.00
6.0 ‐0.21 ‐0.21 0.00
6.5 ‐0.29 ‐0.29 0.00

***2011 and 2012 not used in multi‐year average, prior to addition of buoyancy appendages***
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2702 ‐ 2016 Elipsoid Referenced Dynamic Draft Results
Trim tabs? Jet bale?

Speed 
(m/s)

3rd Order 4th Order Standard

0.0 0.00 0.00 0.00
0.5 0.00 ‐0.04 ‐0.02
1.0 0.00 ‐0.04 ‐0.02
1.5 0.01 ‐0.03 ‐0.01
2.0 0.01 ‐0.02 ‐0.01
2.5 0.02 0.00 0.01
3.0 0.02 0.00 0.01
3.5 0.02 0.00 0.01
4.0 0.00 ‐0.02 ‐0.01
4.5 ‐0.02 ‐0.05 ‐0.04
5.0 ‐0.06 ‐0.10 ‐0.08
5.5 ‐0.12 ‐0.16 ‐0.14
6.0 ‐0.19 ‐0.23 ‐0.21
6.5 ‐0.29 ‐0.29 ‐0.29

***Standard is average of 3rd and 4th order values***
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Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.85
Fwd 

Inboard
3.85

Fwd 
Inboard

3.85
Fwd 

Outboard
3.85

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.85 Stbd Ave 3.85

x x

y y

z -0.1356 z -0.1356

x x x x

y y y y
z -3.313 z -3.308 z -3.426 z -3.428

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.306 z -3.305 z -3.344 z -3.358

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From 2013 Drydock Ave -3.308 From 2013 Drydock Ave -3.389

x x 4.6 x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.750 Calculated from draft mark 4.6 to draft readings Ave 0.750

x x x x

y y y y
z -2.427 z -2.422 z -2.540 z -2.542

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.420 z -2.419 z -2.458 z -2.472

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.694 Ave -2.639

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.4274

Fwd 
Inboard

2.4224 -1
Fwd 

Inboard
2.5404

Fwd 
Outboard

2.5424 -1

Aft 
Outboard

2.4204
Fwd 

Inboard
2.4194

Fwd 
Inboard

2.4584
Aft 

Outboard
2.4724

Port Ave 2.4224 Stbd Ave 2.5034

x x
Waterline y Waterline y PORT, STBD Ave
to IMU  (m) z 2.422 to IMU  (m) z 2.503 2.463

(In CARIS) (In CARIS)

Waterline to IMU Offset

Center of IMU 
Plate  to top of 

IMU

Center of IMU 
Plate  to top of 

IMU

IMU Plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Outboard 4.6 

Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU



Date: 6/14/2013 Personnel: Adler, Reed, Moehl
Location: MOC-A Port ERLL/WRLL
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.66
Fwd 

Inboard
3.65

Port Fwd 
Outboard

3.75
Stbd Fwd 
Outboard

3.59

Aft 
Outboard

3.92 Aft Inboard 3.91
Port Aft 

Outboard
3.85

Stbd Aft 
Outboard

3.78

Port Ave 3.785 Stbd Ave 3.743

x x
y y

z -0.1675 z -0.1675

x x x x
y y y y
z -3.313 z -3.308 z -3.313 z -3.426

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.306 z -3.305 z -3.306 z -3.344

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From 2013 Drydock Ave -3.308 From 2013 Drydock Ave -3.347

x x 4.6 x x

y y y y
z 0.940 z 0.950 z 0.850 z 1.010

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z 0.680 z 0.690 z 0.750 z 0.820

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.815 Calculated from draft mark 4.6 to draft readings Ave 0.858

x x x x
y y y y
z -2.206 z -2.191 z -2.296 z -2.249

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -2.459 z -2.448 z -2.389 z -2.357

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.661 Ave -2.490

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2055

Fwd 
Inboard

2.1905 -1
Fwd 

Inboard
2.2955

Fwd 
Outboard

2.2485 -1

Aft 
Outboard

2.4585
Fwd 

Inboard
2.4475

Fwd 
Inboard

2.3885
Aft 

Outboard
2.3565

Port Ave 2.3255 Stbd Ave 2.32225

x x
Waterline y Waterline y
to IMU  (m) z 2.326 to IMU  (m) z 2.322

(In CARIS) (In CARIS)

Center of IMU 
Plate  to top of 

IMU

Center of IMU 
Plate  to top of 

IMU

IMU Plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Outboard 4.6 M 

Draft Mark

IMU Plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Outboard 4.6 

Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU



Appendix II 
 
 
Echosounder Reports 
 



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

2/11/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth
MVP_2016-02-11_203956

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

140 6.0
140 9.0
320 6.5
320 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

140 6.0
320 6.0
320 6.5
139 6.8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

Ferdinand R. Hassler

Berube, Wilson

winter 2015/2016port hull

042

7125 200kHz port

XTF Line Filename
2016_0420705

Don't Use
Don't Use

Chesapeake Bay VA, Cape Charles

2016_0420705
0721
2006

0712
2006
2012

Don't Use
Don't use

2018



SV Cast # Heading Speed (kts) Remarks
320 6.0
140 6.0
140 7.0
324 7.0
136 7.0

15 m off line, rerun

2016_0420728
XTF Line Filename

2037

2023
0736

rerun 2023
2030



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

050
230
230

2016_0420746
0754
0804
0815

USE PITCH LINES FOR ROLL
offline; aborted. 10m offset, USE PITCH LINES FOR RO

XTF Line Filename

offline; aborted. 10m offset, USE PITCH LINES FOR RO
USE PITCH LINES FOR ROLL



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.36 -0.26 -0.62
0.00 0.44 -0.20 -0.65
0.00 0.45 -0.20 -0.60
0.00 0.40 -0.22 -0.65

0.00 0.41 -0.22 -0.63
0.00 0.04 0.03 0.02
0.00 0.41 -0.22 -0.63

Resulting HVF File Name

MRU Align StdDev gyro 0.02 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 02/19/2016Patrick Berube

PATCH TEST RESULTS/CORRECTORS

Andvick
Morgan

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Berube
Miller

FH_S250_Port_Reson7125_512bms_200kHz_S7K_2016

Used the pitch lines for roll because both roll lines that were in the project ran in the same direction (Morgan)

average



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

2/11/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

320 6.0
140 9.0
320 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

140 6.0
320 6.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

0836

Ferdinand Hassler

Berube, Wilson

winter 2015/2016Port hull

042

7125 Port 400kHz

XTF Line Filename
2016_0420824

offline; aborted

Chesapeake Bay VA, Cape Henry

2016_0420836
0850
0859

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]



SV Cast # Heading Speed (kts) Remarks
140 7.0
320 6.0
140 7.0

0919
0928

2016_0420906 not possible to go slower. Aborted line due to offline.
XTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

060 6.0
240 6.0

XTF Line Filename
2016_0420942
0950



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.65 -0.07 -0.67
0.00 0.52 -0.08 -0.23
0.00 0.66 -0.10 0.05
0.00 0.60 -0.07 -0.80

0.00 0.61 -0.08 -0.41
0.00 0.06 0.01 0.39
0.00 0.61 -0.08 -0.32

Resulting HVF File Name

MRU Align StdDev gyro 0.39 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.04 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

FH_S250_PORT_Reson7125_512bms_400kHz_S7K_2016.hvf

Andvick, Berube, and Morgan looked at Yaw together to come up with consensus due to high std deviation.

Pitch and Roll used averages. Yaw was a consensus after seeing high std dev. 

PATCH TEST RESULTS/CORRECTORS

Morgan
Andvick

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Berube
Miller



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

320 9.0
320 6.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

140 6.0
320 6.0
140
140 6.0
140 6.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename
2016_042_0512

0531
0518

0518
0525
0539

approx 8m off line

approx 10m off line
approx 8 m line

0556



SV Cast # Heading Speed (kts) Remarks
320 6.0
320 6.0
140 6.0

DO NOT USE - OFF LINE
2016_0420548
XTF Line Filename

0611
0604



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

050 6.0
230 6.0

2016_0420643
0650

XTF Line Filename



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.10 0.10 0.55
0.00 0.17 0.08 0.28
0.00 0.10 0.08 0.61
0.00 0.15 0.08 0.50

0.00 0.13 0.09 0.49
0.00 0.04 0.01 0.14
0.00 0.13 0.09 0.49

Resulting HVF File Name

MRU Align StdDev gyro 0.14 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Berube
Morgan

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Andvick
Miller

FH_S250_STBD_Reson7125_512bms_200kHz_S7K_2016.hvf

Did not vary grossly from last year's values

This year's averages



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

2/11/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

317 6.0
317 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

317 6.0
137 6.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

0319

Ferdinand Hassler

Berube, Wilson

Winter 2015-2016Stbd

041

Reson 7125, 400 kHz

XTF Line Filename
2016_0420308

Offshore Cape Charles, Chesapeake Bay, VA

2016_0420308
0330

2016_042_S250S.000

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]



SV Cast # Heading Speed (kts) Remarks
137 6.0
317 6.0

137 6.0
317 6.0

0452

0345
0444

not sufficient coverage over feature. Will rerun
aborted line
~8 m off line (closer to feature)

2016_0420338 not sufficient coverage over feature. Will rerun
XTF Line Filename

0502



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

055 6.0
245 6.0

XTF Line Filename
20160420353
0403



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.10 0.10 0.72
0.00 0.08 0.11 0.43
0.00 0.06 0.09 0.79
0.00 0.00 0.10 0.85

0.00 0.06 0.10 0.70
0.00 0.04 0.01 0.19
0.00 0.06 0.10 0.88

Resulting HVF File Name

MRU Align StdDev gyro 0.19 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

FH_S250_STBD_Reson7125_512bms_400kHz_S7K_2016.hvf

Morgan's Yaw outlier prompted review. After Andvick, Berube and Morgan reviewed together, 0.88 was consensus.

Pitch and Roll use averages. Yaw was consensus of Andvick, Morgan and Berube

PATCH TEST RESULTS/CORRECTORS

Berube
Morgan

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Andvick
Miller



July 9, 2016

Reference Surfaces

Sonar Frequency Line# Line Azimuth Sonar
PORT 200 kHz 1911746 360 S-N PORT
PORT 200 kHz 1911754 180 N-S PORT
PORT 200 kHz 1911800 360 S-N PORT
PORT 200 kHz 1911806 180 N-S PORT
PORT 200 kHz 1911812 360 S-N PORT
PORT 200 kHz 1911819 270 E-W PORT
PORT 200 kHz 1911827 90 W-E PORT
PORT 200 kHz 1911833 270 E-W PORT
PORT 200 kHz 1911839 90 W-E PORT
PORT 200 kHz 1911845 270 E-W PORT

Sonar Frequency Line# Line Azimuth Sonar
STBD 200 kHz 1912021 180 N-S STBD
STBD 200 kHz 1912028 360 S-N STBD
STBD 200 kHz 1912034 180 N-S STBD
STBD 200 kHz 1912041 360 S-N STBD
STBD 200 kHz 1912047 180 N-S STBD
STBD 200 kHz 1912054 270 E-W STBD
STBD 200 kHz 1912102 90 W-E STBD
STBD 200 kHz 1912109 270 E-W STBD
STBD 200 kHz 1912115 90 W-E STBD
STBD 200 kHz 1912121 270 E-W STBD

Reference surfaces for all sonars (200/400 KHz port and starboard) completed at 



Frequency Line# Line Azimuth SV Casts Time (Local) Latitude
400 kHz 1911905 90 W-E 1500
400 kHz 1911912 270 E-W 1845
400 kHz 1911920 90 W-E
400 kHz 1911926 270 E-W
400 kHz 1911934 90 W-E
400 kHz 1911943 360 S-N
400 kHz 1911950 180 N-S
400 kHz 1911957 360 S-N
400 kHz 1912004 180 N-S
400 kHz 1912010 360 S-N

Frequency Line# Line Azimuth
400 kHz 1912132 90 W-E
400 kHz 1912139 270 E-W
400 kHz 1912147 90 W-E
400 kHz 1912154 270 E-W
400 kHz 1912200 90 W-E
400 kHz 1912207 0 S-N
400 kHz 1912213 180 N-S
400 kHz 1912219 0 S-N
400 kHz 1912225 180 N-S
400 kHz 1912232 0 S-N



Longitude



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

7/9/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

15:40:00 AM
SV Cast #1 filename UTC Time Lat Lon Depth (m) Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

025 5.0
025 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

205 9.0
025 9.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1911652
PORT 200kHz Pitch
PORT 200kHz Pitch

Hassler

Morgan, Marshall, Pye

Port

191

Reson 7125/200kHz

S7K Line Filename
1911643

PORT 200kHz Nav/Timing
PORT 200kHz Nav/Timing

Rhode Island Sound

1911632
1911652

S7K Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

S7K Line Filename



205 10.0
205 10.0
205 10.0
205 10.01911739

1911715
1911726

PORT 200kHz Yaw/OK line, last one may be best
PORT 200kHz Yaw/OK line, last one may be best
PORT 200kHz Yaw

1911701 PORT 200kHz Yaw



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

359 9.0
179 9.0

S7K Line Filename
1911604
1911615

PORT 200kHz Roll
PORT 200kHz Roll



Processing Log

7/9/2016
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Morgan, Pye, Marshall191

Predicted: 8452660.tid 

2016_July_Patch_Test_S250.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.49 -0.13 -0.26

Morgan 0.00 0.34 -0.15 -0.15
Blass 0.00 0.40 -0.15 -0.17
Andersen 0.10 0.25 -0.14 -0.28

0.03 0.37 -0.14 -0.22
0.05 0.10 0.01 0.06

Resulting HVF File Name

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Marshall

Final Values based on

Averages
Standard Deviation

FINAL VALUES



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

7/9/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

11:40
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

025 4.0
205 9.0
025 4.0
025 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

205 9.0
025 9.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

S7K Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

S7K Line Filename

Hassler

Morgan, Marshall, Pye

Port

191

Reson 7125

S7K Line Filename
1911426

Do not use/ no s7k/DELETE
Do not use/ no s7k/DELETE
PORT 400kHz Nav timing

Rhode Island Sound

1911312
1911329
1911413

1911437
PORT 400kHz Pitch
PORT 400kHz Pitch

PORT 400kHz Nav timing1911437



205 9.0
205 9.0 PORT 400kHz Yaw

1911447 PORT 400kHz Yaw
1911510



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

359 9.0
179 9.0

1911521
1911532

PORT 400kHz Roll
PORT 400kHz Roll

S7K Line Filename



Processing Log

7/9/2016
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Predicted: 8452660.tid

2016_July_Patch_Test_S250.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Morgan, Pye, Marshall191

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.25 -0.15 ` -0.36
0.00 0.34 -0.15 -0.34
0.00 0.58 -0.15 -0.26
0.00 0.25 -0.13 -0.40
0.00 0.49 -0.14 -0.46

0.00 0.38 -0.14 -0.36
0.00 0.15 0.01 0.07

Resulting HVF File Name

MRU Align StdDev gyro 0.07 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.08 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Marshall
Pye

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Morgan
Andersen
Blass



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

7/9/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

11:15
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

025 4.0
025 9.0

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

205 9.0
025 9.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

1911224
STBD 200kHz Pitch
STBD 200kHz Pitch

S250

Morgan, Marshall, Pye

Starboard pontoon

191

7125/200kHz

XTF Line Filename
1911215

STBD 200kHz Nav timing
STBD 200kHz Nav timing

Rhode Island Sound

1911200
1911224

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename



205 9.0
205 9.01911259 STBD 200kHz Yaw

1911246 STBD 200kHz Yaw



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

359 9.0
179 9.0

XTF Line Filename
1911131
1911141

STBD 200kHz Roll
STBD 200kHz Roll



Processing Log

7/9/2016
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Morgan, Pye, Marshall191

Predicted: 8452660.tid

2016_July_Patch_Test_S250.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
Pye 0.00 0.25 0.06 0.80
Morgan 0.00 0.33 0.06 0.63
Blass 0.00 0.33 0.06 0.79

0.00 0.33 0.07 0.55

0.00 0.31 0.06 0.69
0.00 0.04 0.01 0.12

Resulting HVF File Name

MRU Align StdDev gyro 0.12 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Andersen



Ferdinand R. Hassler
Multibeam Echosounder Calibration

Vessel

7/9/2016
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

8:25
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

11:15
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

021 4kts

021 8kts

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

205 8kts
025 8kts

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

S250

191 Rhode Island Sound

Morgan, Marshall, Pye

7125 200kHz Starboard pontoon

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

XTF Line Filename
1910905 STBD 400khz Slow timing line (recorded on C:)
1910915 Logging test, discard
1910930 STBD 400khz pitch/timing combo

XTF Line Filename
1910920 STBD 400khz Pitch line to SW
1910930 STBD 400khz pitch/timing combo

XTF Line Filename



205 9kts
205 10kts
205 10kts

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

359 9kts
179 10.0

1910942 STBD 400kHz yaw, 13 meters right of track line
1911010 STBD 400kHz yaw, only partial feature, to be redone
1911023 STBD 400kHz yaw, call it good

XTF Line Filename
1911044 STBD 400kHz roll
1911055 STBD 400kHz roll



Processing Log

7/9/2016
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Lines merged

Data cleaned to remove gross fliers

Data converted --> HDCS_Data in CARIS

2016_July_Patch_Test_S250.svp

Predicted: 8452660.tid

Compute correctors in this order

191 Morgan, Pye, Marshall

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias
Do not enter/apply correctors until all evaluations are complete and analyzed.



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
Pye 0.00 0.65 0.05 0.76
Blass 0.00 0.50 0.08 0.75
Andersen 0.00 0.70 0.08 0.60

0.00 0.62 0.07 0.70
0.00 0.10 0.02 0.09

Resulting HVF File Name

MRU Align StdDev gyro 0.09 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Standard Deviation
FINAL VALUES

Final Values based on

Averages

PATCH TEST RESULTS/CORRECTORS



   
 

NOAA Ship E.R. Hassler Survey Launch 
2702 Report 

R2Sonic visited the NOAA Ship E.R. Hassler the week of 16 Nov 2015.  This is a brief report on that 
visit and recommendations to be considered. 

The physical installation has the face of the projector even with the face of the receiver. With this 
orientation it is very important to put the vertical relationship, between the projector’s acoustic 
center and the receiver’s acoustic center in the control software.  With the standard R2Sonic 
mounting frame, the vertical relationship between the two acoustic centers is 0.119m.  To insure 
accurate sounding depths, when this vertical distance is changed, it is necessary to measure the new 
vertical offset and enter the new value in the Projector Z offset (Installation Settings).  The 
measurement resulted in a new Projector Z offset of +0.054m; this was entered into Sonic Control’s 
Installation Settings. 

It was brought up, during initial conversations with the survey officer, that the Sonic sonars can work 
simultaneously with most single beam echosounders such as the navigation echosounder on board 
the launch.  With the frequency agility of the sonar, it is easy to select a frequency that is off the 
operating frequency or off a harmonic of that frequency.  With a 200kHz single beam echosounder, a 
sonar frequency of 330kHz works very well.   On the water, this was tested and proved to be a 
satisfactory solution and allowed both the navigation echosounder and the multibeam sonar to be 
operated continuously without any cross talk or interference. 

Initially there were issues with providing RTCM or CMR corrections to the Applanix POS MV using the 
default equipment installed on the survey launch.  This did take up the entire first day of operations, 
but was solved by removing equipment from the Hassler and installing this on the launch and 
configuring it to output corrections to the POS MV.  Once we had accurate positioning, with the POS 
MV, the GAMS calibration could be completed.  We will not go into the GAMS calibration in this 
document as it is well known to the personnel of NOAA. 

One of the prime tasks that R2Sonic wished to complete was an extensive multibeam calibration, 
better known as the Patch Test.  To this end, an area was chosen that historically has been used for 
calibration and testing. 

 

Figure 1: Calibration and test area 



   
 
A thorough calibration calls for a large data set, for each computation, in order to derive a valid 
mean and standard deviation.  Sea and wind conditions were such that there was some variability in 
the maneuvering of the vessel.  The implication of the variability was that at times, where it was 
desirable for the sonar head to pass over the same feature, in both directions, the head passed over 
a slightly different area of the feature.  When this occurs, the Yaw computation is very critical for the 
accuracy of the Pitch computation, even though the Pitch is computed prior to the Yaw solution.  If 
the Yaw is greater than 1.0°, it is advisable to re-compute the Pitch offset using the determined Yaw 
offset; this was the case with the launch patch test data. 

LINES ROLL PITCH 
Pitch - Yaw 

adj. YAW-LINES YAW 
1715 1720 -24.90 N/A 0.60 1715 1723 1.30 
1723 1725 -24.85 0.10 0.20 1720 1725 1.50 
1732 1734 -24.80 -0.10 0.45 1723 1732 1.30 
1737 1738 -24.75 N/A 0.45 1725 1734 1.30 
1740 1742 -24.85 0.15 0.35 1732 1737 1.10 
1802 1804 -24.85 0.20 0.40 1734 1738 0.90 
1832 1833 -24.75 0.35 0.50 1832 1840 1.20 
1835 1836 -24.75 0.45 0.55 1742 1833 1.20 

  

   Ave. σ 

 ROLL -24.81 0.06 

 
PITCH 0.19 0.19 

 
YAW 1.23 0.18 

    Yaw adj Pitch 0.45 0.07 
 

As can be seen the final values are:  Roll = -24.81°; Pitch = +0.45°; Yaw = +1.23° 

Any thorough calibration should be truthed by having the vessel go about a feature in various 
directions and then comparing each run to see if the feature shifts in any direction. The following 
day we attempted to perform the truthing survey.  Although the data were collected in different 
directions, over the features of the calibration area, the wind and seas had picked up considerably. 
This made vessel handling a serious issue, which we attempted to overcome by increase speed.   
Increasing speed induced squat; no vessel squat data is currently available.   Although all cross 
sections, over the features, showed no horizontal shift, a slight vertical shift was observed.  Without 
squat data or employing RTK heights, the slight vertical shift was attributed to the vessel squat.  This 
is a valid assumption. 

 



   
 
It is recommended that as soon as possible a squat determination be made for the launch or that 
RTK heights be employed to eliminate the effects of squat. 

Further, it is recommended that a permanent solution for GPS corrections be found for the POS MV. 

Further, it is recommended that a bar check or lead line be performed to verify the surveyed-in 
offsets on the launch.  The adjustment of the Projector Z offset was critical to accurate depths, so is 
the physical verification of the surveyed-in offsets by either the bar check or lead line methods. 

Further, it is recommended, due to the potential change in survey personnel that will be running the 
launch, that a check list be created that covers all the necessary, preliminary, checks prior to a 
multibeam survey. 

  

R2Sonic verifies that the 2702 Survey Launch, as far as the Sonic 2022 multibeam is concerned, is 
survey ready. 

 

Thank you, 

 

Charles W Brennan 
R2Sonic LLC 
 

 



FH 2016 Sidescan Calibration
Side Scan run on Dn068.
Contact is: R"6" Buoy Block Off Duck, NC

MBES Position of Contact

Lat Long

36.2637083 ‐75.5936194

SSS Contacts Lat Diff (m) Long Diff (m) Distance (m)

1 36.2637100 ‐75.5936370 0.188904001 ‐1.576896663 1.588171215

2 36.2637150 ‐75.5936350 0.744504 ‐1.397703861 1.583623153

3 36.2637210 ‐75.5936350 1.411224 ‐1.397703861 1.986234946

4 36.2637100 ‐75.5936260 0.188904001 ‐0.591336249 0.620776353

5 36.2637050 ‐75.5936020 ‐0.366696 1.558977382 1.60152316

6 36.2637130 ‐75.5936250 0.522264001 ‐0.501739848 0.724225491

7 36.2637120 ‐75.5935710 0.411144 4.336465822 4.355912673

8 36.2636760 ‐75.5936040 ‐3.589176 1.37978458 3.845255498

9 36.2636940 ‐75.5936250 ‐1.589016 ‐0.501739848 1.666347719

10 36.2637250 ‐75.5936180 1.855704 0.125434961 1.859938511

11 36.2637410 ‐75.5936120 3.633624001 0.66301337 3.693617482

12 36.2636710 ‐75.5936290 ‐4.144775999 ‐0.860125454 4.233082078

13 36.2637070 ‐75.5936580 ‐0.144456 ‐3.458421091 3.461436693

N 13 Average ‐0.067526769 ‐0.170922366 2.401549613 ‐0.11922457

DOF: 2N‐1 25 StDev 2.089422731 1.896534039 1.955707889

Criteria: 95% Confidence that any future measurement will not give a positional error 

greater than 10 meters. 

Assuming x and y errors are goverened by the same normal distribution, the

square of the distance error is governed by Chi-squared statistics. 

So:

Setting the distance error equal to 10 meters and using the Chi-squared

value for one degree of freedom and alpha = 0.05, solve for the maximum value

for the true value of the standard deviation of the x and y error.

Distance Error Limit (meters) 10

Max. x,y Std Deviation 5.1

The sample estimate of the standard deviation will also be Chi-squared distributed

At a 95% confidence interval the standard deviation range is:

low best est. high

x,y StDev 1.5 2.0 2.7

And the 95% confidence inteval of the positioning error is:

Error 3.0 3.8 5.3 PASS

Note: FPM method of 1.96*RMS standard deviation

Error: 5.530718786 PASS
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Appendix III 
 
 
Positioning and Attitude System Reports 
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During the period of May16th to May 18th, 2011 two POSMV systems were commissioned 
aboard NOAA vessel Ferdinand Hassler. The following is a summary of the events and final 
observations.  
 
Chronology: 
May 16th-  

Travel from Houston TX to New Orleans LA. Overnight in Gulfport MS with the 
intention of meeting the ship in the morning to conduct dockside testing in the 
morning before the ship sets sail in the afternoon. Informed by Steve Laverty 
there has been a change in plan and the CO wants to depart the dock at 0900 
tomorrow instead.  
 

May 17th-  
 Arrive ship 0730. Brief review of POSMV installation with Briana Welton followed 

by cursory inspection.  Both POSMV systems are up and running with no errors. 
Collected a set of dockside POSMV data from both systems for processing in 
POSPAC later today. Plan is to meet at the NOAA facility in Pascagoula at 0630 
and transit out to ship in small boat.  

 
May 18th-  0630- Depart Pascagoula for Ferdinand Hassler. Upon arrival commenced 

system inspection and diagnostics. No faults found. Conducted two GAMS 
calibrations on both POSMV systems and  completed system acceptance testing.  

 
   
Calibration and testing results: 

1. The GAMS calibration was completed on May 18th and checked against the calculations 
derived from the survey report. Further comparisons are required but it appears that the 
survey calculations differ somewhat from the GAMS measured values.  

Notes: 
  As a result of post processing the data set collected during commissioning, it was 
discovered that the POSMV IMU’s were actually reversed at the back of the POSMV PCS units. 
Because of the symmetry in the two systems, these errors were not immediately obvious during 
the trials; however the lever arm errors were apparent in the data set.  After physically changing 
the IMU inputs the processed calibration data was now reasonable when compared to the 
measured survey results. A new GAMS calibration was performed by the NOAA personnel after 
the IMU cables were returned to the correct orientation and the information below is based upon 
the correct orientation.  

Bruce A. Francis Applanix Corporation. 
17461 Village Green Drive 
Houston TX 77040 
USA 
Tel: (713) 896-9900 
Fax: (713) 896-9919 
bfrancis@applanix.com 
http://www.applanix.com 

 Company: Oak Management 

Attention 
of: 

Steve Laverty   

Email:   steve.laverty@oakmanagement.com 

From: Bruce A. Francis 

Date: 18 May, 2011  

Ref.: POSMV Installation aboard  

Ferdinand Hassler-SWATH 
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Recommendations:  
 
While the large separation between the GPS antennas across decks will improve heading 
accuracy, there is a possibility that flexure in the ship will cause poor GAMS performance as the 
baseline vectors may become unstable. We were unable to fully test this configuration in a calm 
sea but if this turns out to be the case after the ship experiences a modest increase in sea state, 
the solution might be to extend the separation between the antennas on the individual mounts 
and switch the antenna input to the POS from cross decks to using the pairs from each side to 
their corresponding POS unit. The minimum separation should be 1 meter whereas now the 
distance is only about 0.6m and slightly too short to expect normal GAMS performance.  
 
 
 
 

 
Submitted By: 
Bruce A. Francis 
Customer Support Engineer 
Marine Products 
713-896-9900 
bfrancis@applanix.com 
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Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location Port Side 
PCS Serial Number 3187 

IMU Serial Number 
Top Hat 

 
804 (Cable S/N 105) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.2.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.2.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 PORT IMU 
Ref to IMU 0.0 0.0 0.0 PORT IMU 
Ref to Primary GPS 1.395 1.05 -13.084 Port Aft antenna 
Ref to Secondary GPS 1.418 9.188 -13.080 Strb Aft antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 
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General System information: 
 
Options included- RTK (RTK-0); True Heave (THV-0); (DPW-0) Password protection 
Disabled 
 
Port POSMV 

 
 
 
 
Basic installation geometry: 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(1)\Swath Port IMU\Extract 
Output kernel       : Swath Port IMU 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307750.275 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3187; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950     SN:4814A14457, v.00232, channels:24; 
   Secondary GPS Version: BD950     SN:4814A14447, v.00232, channels:24; 
   Total Hours          :    561.4; Number of Runs:     53 
   Average Length of Run:   10.6; Longest Run:  126.2; Current Run:   12.1; 
-------------------------------------------------------------------------------- 
307750.275 : Diffcorr2 time1 gap: start 0.0, end 307750.2749 
307750.280 : IMU type: IMU2  Data rate = 200 Hz 
307750.280 : Extracting Group 4 : Time-tag data 
307750.290 : SNV status changed to 0  (Full Nav) 
307751.070 : Primary GNSS receiver type is GNSS13. 
307751.090 : Secondary GNSS receiver type is GNSS13. 
307755.275 : GenB( 9):  GAMS solution in use CLEARED. 
307756.275 : GenB( 9):  GAMS solution in use SET. 
307758.275 : GenB( 9):  GAMS solution in use CLEARED. 
-------------------------------------------------------------------------------- 
307759.275 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.395  1.050  -13.084 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
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   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------- 
307759.275 : Message 22: Aiding sensor install parameters 
   DMI scale factor:                    0.00 
   Reference-DMI lever arm:             0.00    0.00    0.00 
   DVS scale factor correction:         1.00 
   Reference-DVS lever arm:             0.00    0.00    0.00 
   Reference-DVS attitude:              0.00    0.00    0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 120: Heave and sensor 1&2 install parameters 
   Reference->Sensor1 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor2 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor1 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Sensor2 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Center of Rotation in meters:                    0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    232 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339734242 -88.576108929 -24.927 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.112 
   A-B baseline vector:           -0.060 8.112 0.021 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
Available subsystems                  :  IMU 
                                      :  Primary GNSS 
                                      :  Secondary GNSS 
                                      :  Differential Corrections 
Vehicle to reference alignment angles :  0.000  0.000  0.000 
Multipath setting                     :  LOW 
Reference to IMU lever arm            : -0.008 -0.031  0.130 
Reference to IMU alignment angles     :  0.000  0.000  0.000 
Reference to primary GNSS lever arm   :  1.395  1.050 -13.084 
GAMS antenna separation               :  8.104 
GAMS baseline vector                  :  0.152  8.103 -0.004 
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GAMS heading calibration threshold    :  0.500 
GAMS heading correction               :  0.000 
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Observed GAMS values derived from the field calibration: 
 
Port GAMS Cal #1 
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Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
 
 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
Com port #5 settings as installed 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Heave data plot: 
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The heave plot above shows the relationship between the Real-time (RT) heave and the True (or 
delayed TH) heave measurements. The green line relates to quality control (QC) and represents 
the difference between the two values. When the delta between the RT and TH exceeds 5cm or 
5% of total heave (pink line) then the radio light on the main controller screen will turn from green 
to red but does not affect the real-time heave data being collected. Quite often this occurs after 
the vessel makes a turn or an abrupt change in speed and is not necessarily cause for alarm.  
The heave filter has a 105 second buffer so the event which may have caused the impulse 
happened in the past.  A red light merely calls the users attention to the difference and may also 
suggest that the filter settings need to be refined if the QC value is continually out of bounds.   
 
Note: The TrueHeave data filter is delayed about 3 minutes from the TH value. Also, Group 111 & 
113 must be enabled in the Ethernet Real-time logging page.  In addition, this filter should be 
adjusted as required for changes in the local swell conditions.   
Heave Settings valid for both POSMV systems.  
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The main controller screens below shows normal POSMV operation. POS Mode is FULL 
indicating that all user accuracy settings have been satisfied.  Note, when using RTK the 
position threshold should be set to a smaller value i.e. 0.100m or whatever is specified in 
the survey parameters.  Exceeding any of the limits below will cause one of the radio 
lights to turn red and the POS mode will no longer report “Full Navigation” This however 
only affects the flag in the GGA or GGK message and not the performance.  
 
 

 
 
Port POSMV Final Navigation      
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Port side antenna and IMU mounting:  
 
 

 
 

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  NOAA  
  Ferdinand Hassler   

 Page 16 of 26 

 
 
 
 
Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location STRB Side 
PCS Serial Number 3189 

IMU Serial Number 
Top Hat 

 
803 (Cable S/N 104) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.1.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.1.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 STRB IMU 
Ref to IMU 0.0 0.0 0.0 STRB IMU 
Ref to Primary GPS 1.929 -11.199 -13.084 Port FWD antenna 
Ref to Secondary GPS 1.953 -3.056 -13.083 Strb FWD antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  NOAA  
  Ferdinand Hassler   

 Page 17 of 26 

 
 
 
STRB POSMV 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.003 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(2)\Mission 1\Extract 
Output kernel       : Mission 1 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
Opening file: E:\Clients config, IP, & test results\Swath 250 Testing\Final Report 
Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
307625.639 : Output time 1 is in UTC time 
307625.639 : Output time 2 is in POS time 
307625.639 : Output distances are in POS distance 
307625.639 : IMU type: IMU2  Data rate = 200 Hz 
307625.639 : Extracting Group 4 : Time-tag data 
307625.649 : SNV status changed to 0  (Full Nav) 
307626.069 : Primary GPS receiver type is GPS13. 
307626.094 : Secondary GPS receiver type is GPS13. 
307626.144 : Extracting Group 10: The General Status & FDIR data. 
307626.144 : GenA( 2):  IIN quadrant resolved SET. 
307626.144 : GenA( 3):  IIN fine align active SET. 
307626.144 : GenA( 4):  IIN navigator initialized SET. 
307626.144 : GenA( 5):  IIN navigator alignment active SET. 
307626.144 : GenA( 7):  IIN full navigation solution SET. 
307626.144 : GenA( 8):  IIN initial position valid SET. 
307626.144 : GenA(16):  RAM config != NVM SET. 
307626.144 : GenB( 0):  IIN user attitude performance SET. 
307626.144 : GenB( 1):  IIN user heading performance SET. 
307626.144 : GenB( 2):  IIN user position performance SET. 
307626.144 : GenB( 3):  IIN user velocity performance SET. 
307626.144 : GenB( 8):  GAMS installation parameters valid SET. 
307626.144 : GenB( 9):  GAMS solution in use SET. 
307626.144 : GenB(10):  GAMS solution OK SET. 
307626.144 : GenB(16):  Primary GPS configuration file sent SET. 
307626.144 : GenB(18):  Primary GPS in CA mode SET. 
307626.144 : GenB(23):  Primary GPS observables in use SET. 
307626.144 : GenB(24):  GAMS secondary GPS observables in use SET. 
307626.144 : GenC( 6):  RTCM Type 1 or 9 in use SET. 
307626.144 : GenC(13):  IIN in RTCM DGPS aided mode SET. 
307626.144 : FDIR1(13): Ephemeris missing SET. 
-------------------------------------------------------------------------------- 
307626.144 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3189; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950    SN:4808A98939, v.00232, channels:24; 
   Secondary GPS Version: BD950  SN:4642A73565, v.00232, channels:24; 
   Total Hours          :    789.9; Number of Runs:     66 
   Average Length of Run:   12.0; Longest Run:   84.0; Current Run:   12.2; 
-------------------------------------------------------------------------------- 
307626.144 : Diffcorr2 time1 gap: start 0.0, end 307626.1439 
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-------------------------------------------------------------------------------- 
307633.139 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.929  -11.199  -13.076 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 120: Heave and sensor 1&2 install parameters 
   Reference-Sensor1 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor2 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor1 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Sensor2 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Centre of Rotation in meters:                 0.000  0.000  0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    231 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339738973 -88.576114608 -17.526 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.122 
   A-B baseline vector:           0.170 8.120 -0.003 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
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Observed GAMS values derived from the field calibration: 
STRB GAMS Cal #1 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  NOAA  
  Ferdinand Hassler   

 Page 22 of 26 

 
 
 
Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
 
Com port #5 settings as installed 
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STRB POSMV Final Navigation 
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STRB side antenna and IMU mounting:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
STRB IMU Mount 

 







Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Ferdinand R. Hassler Vessel: 2702
Date: 3/3/2016 Dn:

Personnel: Berube, Schoolcraft, Morgan

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 37 14 22.5

Lon 76 29 58.9

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency:

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS 

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35

NOAA POS/MV Calibration Report

N

Secondary GPS

RTK AHB

York River



PDOP 1.8 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration
Baseline Vector

Two Antenna Separation (m) X Component 

Heading Calibration Threshold YComponent 

Heading Correction Z Component 

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 2009

End time: 2011

Heading accuracy achieved for calibration: 0.230 before 0.028 after

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values
Baseline Vector

Two Antenna Separation (m) X Component 

Heading Calibration Threshold YComponent 

Heading Correction Z Component 

GAMS Status Online

Save Settings

Calibration Notes:



Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the
twice-rotated x-axis to align one frame with the other.

SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)



$INVTG $PASHR TB x $INZDA set as GP
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None

COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)



Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Ar
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever 
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Fram
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Fram
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled
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Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Ferdinand R. Hassler Vessel: Ferdinand Hassler
Date: 2/11/2016 Dn: 42
Personnel: Berube, Wilson

PCS Serial # IMU Serial #

IP Address: 129.100.1.232

POS controller Version (Use Menu Help > About) 8.15

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat

Lon

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 289 kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.788 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration
Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

Configuration Notes:

NOAA POS/MV Calibration Report

Chesapeake Bay, Cape Charles

Secondary GPS

N

Driver, VA





POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: aprox 0220

End time: 236

Heading accuracy achieved for calibration: 0.023

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values
Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

GAMS Status Online x

Save Settings x

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 2012_042_Initial_GAMS

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the
twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here) com2
$INVTG $PASHR TB x $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS x $PPS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None

COM3

Baud Rate Rate Parity Data Stop

$GPRMC

Output Select
None

Input Select Input

? Input Type

Line



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)



Frame Control (Use Tools > Config) couldn’t open menu

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Ferdinand R. Hassler Vessel: Ferdinand Hassler
Date: 2/11/2016 Dn: 42
Personnel: Berube, Wilson

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 8.15

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 37 14 40

Lon 76 5 29

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: 29 kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.794 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration
Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

Configuration Notes:

NOAA POS/MV Calibration Report

Chesapeake Bay, offshore Cape Charles

Secondary GPS

N

Driver, VA





POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: Approx 0220

End time: 237

Heading accuracy achieved for calibration: 0.023

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values
Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

GAMS Status Online x

Save Settings x

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 2016_042_Initial_GAMS

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the
twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here) NMEA Output applied to C   
$INVTG $PASHR TB x $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS x INPPS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None

COM3 COM4

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line



SETTINGS Continued
Heave Filter (Use Settings > Heave)

20 Heave Bandwidth
0.707 Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)



Frame Control (Use Tools > Config) Couldn't open menu

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



Appendix IV 
 
 
Sound Speed Sensor Reports 
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Service

Customer Information:

Report

Company Atlantic Marine Center Date 1/22/2016

Contact Thanh Loi

PO Number TBD

RMA Number 86435N

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Serial Number 19P32914-4480

Model Number SBE 19Plus

Services Requested:

1.  Evaluate/Repair Instrumentation.

2.  Perform Routine Calibration Service.

Problems Found:

Services Performed:

1.  Performed initial diagnostic evaluation.

 

2.  Calibrated the pressure sensor.

 

3.  Performed "Post Cruise" calibration of the temperature & conductivity sensors.

 

4.  Performed complete system check and full diagnostic evaluation.

 

Special Notes:

Friday, January 22, 2016 Page 4 of 7



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/12/2016

Serial Number: 19P32914-4480

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



-0.002

-0.001

0

0.001

0.002

0 1 2 3 4 5 6 7

R
e
s
id

u
a
l 
(S

/m
)

Conductivity (S/m)

22-Mar-15 0.9999602
12-Jan-16 1.0000000

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

f = Instrument Output (Hz) / 1000.0

t = temperature (°C);    p = pressure (decibars);    δ = CTcor;    ε = CPcor;

Conductivity (S/m) = (g + h * f
2
+ i * f

3
 + j * f

4
) /10 (1 + δ * t + ε * p)

Residual (Siemens/meter) = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4480
CALIBRATION DATE: 12-Jan-16

SBE 19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -9.833041e-001
h =  1.352032e-001
i = -1.746279e-004
j =  3.287798e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

BATH TEMP
(° C)

BATH SAL
(PSU)

BATH COND
(S/m)

INSTRUMENT
OUTPUT (Hz)

INSTRUMENT
COND (S/m)

RESIDUAL
(S/m)

22.0000
1.0000
4.5000
15.0000
18.5000
24.0000
29.0000
32.5000

0.0000
34.6107
34.5927
34.5549
34.5462
34.5361
34.5320
34.5295

0.00000
2.96006
3.26570
4.24293
4.58639
5.14153
5.66097
6.03161

2699.13
5400.26
5604.88
6213.17
6412.98
6723.08
7000.42
7191.58

0.0000
2.9601
3.2657
4.2429
4.5864
5.1416
5.6610
6.0316

0.00000
-0.00001
0.00001
-0.00002
-0.00001
0.00003
-0.00001
0.00000

Date, Slope Correction

POST CRUISE

CALIBRATION
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y = thermistor output (counts)

t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2
 

x = instrument output - PTCA0 - PTCA1 * t - PTCA2 * t
2
 

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (PSIA) = PA0 + PA1 * n + PA2 * n
2
 

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4480
CALIBRATION DATE: 08-Jan-16

SBE 19plus PRESSURE CALIBRATION DATA
5076 psia S/N 3336

COEFFICIENTS:
PA0 =
PA1 =
PA2 =
PTEMPA0 =
PTEMPA1 =
PTEMPA2 =

1.272218e+000
1.569654e-002
-6.715534e-010
-6.721580e+001
 5.151440e+001
-5.100431e-001

PTCA0 =
PTCA1 =
PTCA2 =
PTCB0 =
PTCB1 =
PTCB2 =

 5.242189e+005
 1.594674e+000
 8.265540e-002
 2.508287e+001
-2.500000e-005
 0.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE
(PSIA)

INSTRUMENT
OUTPUT (counts)

THERMISTOR
OUTPUT (volts)

COMPUTED
PRESSURE (PSIA)

RESIDUAL
(%FSR)

14.64
1114.89
2114.86
3114.68
4114.84
5064.92
4114.83
3114.71
2114.84
1114.93
14.64

525160.0
595449.0
659716.0
724364.0
789368.0
851458.0
789382.0
724382.0
659737.0
595458.0
525158.0

1.8
1.8
1.8
1.8
1.8
1.8
1.8
1.8
1.8
1.8
1.8

14.77
1114.68
2114.55
3114.76
4114.81
5064.73
4115.02
3115.04
2114.88
1114.82

14.73

0.00
-0.00
-0.01
0.00

-0.00
-0.00
0.00
0.01
0.00

-0.00
0.00

TEMP
(°C)

THERMISTOR
OUTPUT (volts)

INSTRUMENT
OUTPUT (counts)

32.50
29.00
24.00
18.50
15.00
4.50
1.00

1.97
1.90
1.80
1.69
1.62
1.41
1.34

525234.03
525210.10
525179.42
525152.05
525137.68
525103.81
525095.58

TEMPERATURE (°C) SPAN (mV)
-5.00
35.00

25.08
25.08

Date, Offset (%FSR)
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n = Instrument Output (counts)

MV = (n - 524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15

Residual (°C) = instrument temperature - bath temperature

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4480
CALIBRATION DATE: 12-Jan-16

SBE 19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  1.269875e-003
a1 =  2.564428e-004
a2 =  7.859616e-007
a3 =  1.180083e-007

BATH TEMP
(° C)

INSTRUMENT
OUTPUT (counts)

INST TEMP
(° C)

RESIDUAL
(° C)

     1.0000
     4.5000
    15.0000
    18.5000
    24.0000
    29.0000
    32.5000

   619138.288
   549768.712
   377664.542
   331462.322
   268748.983
   221011.237
   192174.712

     1.0000
     4.4999
    14.9999
    18.5002
    23.9999
    28.9999
    32.5001

    0.0000
   -0.0001
   -0.0001
    0.0002
   -0.0001
   -0.0001
    0.0001

Date, Offset (mdeg C)

POST CRUISE

CALIBRATION



Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/12/2016

Serial Number: 19P32914-4480

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00080 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Service

Customer Information:

Report

Company Atlantic Marine Center Date 1/22/2016

Contact Thanh Loi

PO Number TBD

RMA Number 86435N

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Serial Number 19P36399-4642

Model Number SBE 19Plus

Services Requested:

1.  Evaluate/Repair Instrumentation.

2.  Perform Routine Calibration Service.

Problems Found:

1.  The switch magnet was found to have corrosion damage.

Services Performed:

1.  Performed initial diagnostic evaluation.

 

2.  Installed NEW switch magnet assembly.

 

3.  Calibrated the pressure sensor.

 

4.  Performed "Post Cruise" calibration of the temperature & conductivity sensors.

 

5.  Performed complete system check and full diagnostic evaluation.

 

Special Notes:

Friday, January 22, 2016 Page 5 of 7



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/12/2016

Serial Number: 19P36399-4642

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:
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f = Instrument Output (Hz) / 1000.0

t = temperature (°C);    p = pressure (decibars);    δ = CTcor;    ε = CPcor;

Conductivity (S/m) = (g + h * f
2
+ i * f

3
 + j * f

4
) /10 (1 + δ * t + ε * p)

Residual (Siemens/meter) = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4642
CALIBRATION DATE: 12-Jan-16

SBE 19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.024191e+000
h =  1.266662e-001
i =  7.221811e-005
j =  1.200735e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

BATH TEMP
(° C)

BATH SAL
(PSU)

BATH COND
(S/m)

INSTRUMENT
OUTPUT (Hz)

INSTRUMENT
COND (S/m)

RESIDUAL
(S/m)

22.0000
1.0000
4.5000
15.0000
18.5000
24.0000
29.0000
32.5000

0.0000
34.6107
34.5927
34.5549
34.5462
34.5361
34.5320
34.5295

0.00000
2.96006
3.26570
4.24293
4.58639
5.14153
5.66097
6.03161

2840.16
5591.29
5800.82
6424.28
6629.27
6947.54
7232.35
7428.56

0.0000
2.9601
3.2657
4.2429
4.5864
5.1416
5.6610
6.0312

0.00000
-0.00000
0.00001
-0.00003
0.00001
0.00003
-0.00001
-0.00038

Date, Slope Correction

POST CRUISE

CALIBRATION
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y = thermistor output (counts)

t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2
 

x = instrument output - PTCA0 - PTCA1 * t - PTCA2 * t
2
 

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (PSIA) = PA0 + PA1 * n + PA2 * n
2
 

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4642
CALIBRATION DATE: 08-Jan-16

SBE 19plus PRESSURE CALIBRATION DATA
508 psia S/N 5632

COEFFICIENTS:
PA0 =
PA1 =
PA2 =
PTEMPA0 =
PTEMPA1 =
PTEMPA2 =

6.581024e-001
1.547891e-003
7.193046e-012
-7.514541e+001
 4.830836e+001
-2.203947e-001

PTCA0 =
PTCA1 =
PTCA2 =
PTCB0 =
PTCB1 =
PTCB2 =

 5.322959e+005
 2.256678e+001
-1.620840e-001
 2.569025e+001
-3.500000e-004
 0.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE
(PSIA)

INSTRUMENT
OUTPUT (counts)

THERMISTOR
OUTPUT (volts)

COMPUTED
PRESSURE (PSIA)

RESIDUAL
(%FSR)

14.64
104.91
204.91
304.92
404.92
504.93
404.92
304.93
204.92
104.92
14.64

541747.0
600028.0
664558.0
729042.0
793494.0
857910.0
793514.0
729060.0
664574.0
600048.0
541755.0

2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0
2.0

14.64
104.90
204.91
304.91
404.91
504.92
404.94
304.93
204.93
104.93
14.64

0.00
-0.00
-0.00
-0.00
-0.00
-0.00
0.00
0.00
0.00
0.00

-0.00

TEMP
(°C)

THERMISTOR
OUTPUT (volts)

INSTRUMENT
OUTPUT (counts)

32.50
29.00
24.00
18.50
15.00
4.50
1.00

2.25
2.18
2.07
1.96
1.88
1.66
1.59

542116.64
542074.78
542005.74
541916.37
541857.41
541653.43
541578.71

TEMPERATURE (°C) SPAN (mV)
-5.00
35.00

25.69
25.68

Date, Offset (%FSR)
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n = Instrument Output (counts)

MV = (n - 524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15

Residual (°C) = instrument temperature - bath temperature

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4642
CALIBRATION DATE: 12-Jan-16

SBE 19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  1.184792e-003
a1 =  2.769344e-004
a2 = -1.221819e-006
a3 =  2.009333e-007

BATH TEMP
(° C)

INSTRUMENT
OUTPUT (counts)

INST TEMP
(° C)

RESIDUAL
(° C)

     1.0000
     4.5000
    15.0000
    18.5000
    24.0000
    29.0000
    32.5000

   625326.780
   556563.966
   385279.492
   339089.847
   276210.542
   228181.881
   199092.915

     1.0000
     4.4999
    15.0000
    18.5001
    23.9999
    29.0000
    32.5000

    0.0000
   -0.0001
    0.0000
    0.0001
   -0.0001
    0.0000
    0.0000

Date, Offset (mdeg C)

POST CRUISE

CALIBRATION



Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/12/2016

Serial Number: 19P36399-4642

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/12/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00038 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Service

Customer Information:

Report

Company Atlantic Marine Center Date 1/22/2016

Contact Thanh Loi

PO Number TBD

RMA Number 86435N

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Serial Number 19P65591-6918

Model Number SBE 19Plus

Services Requested:

1.  Evaluate/Repair Instrumentation.

2.  Perform Routine Calibration Service.

Problems Found:

1.  No comms upon arrival.  The U21 component was found to be bad.

Services Performed:

1.  Performed initial diagnostic evaluation.

 

2.  Performed internal inspection and O-ring replacement.

 

3.  Performed hydrostatic pressure test.

 

4.  Calibrated the pressure sensor.

 

5.  Performed "Post Cruise" calibration of the temperature & conductivity sensors.

 

6.  Performed complete system check and full diagnostic evaluation.

 

Special Notes:

Friday, January 22, 2016 Page 6 of 7



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/18/2016

Serial Number: 19P65591-6918

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/16/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00040 PSU/monthPSU/monthPSU/monthPSU/month

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/monthPSU/monthPSU/monthPSU/month

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:
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f = Instrument Output (Hz) / 1000.0

t = temperature (°C);    p = pressure (decibars);    δ = CTcor;    ε = CPcor;

Conductivity (S/m) = (g + h * f
2
+ i * f

3
 + j * f

4
) /10 (1 + δ * t + ε * p)

Residual (Siemens/meter) = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6918
CALIBRATION DATE: 16-Jan-16

SBE 19plus V2 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -9.862473e-001
h =  1.555550e-001
i = -3.785908e-004
j =  5.253847e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006

BATH TEMP
(° C)

BATH SAL
(PSU)

BATH COND
(S/m)

INSTRUMENT
OUTPUT (Hz)

INSTRUMENT
COND (S/m)

RESIDUAL
(S/m)

22.0000
1.0000
4.4999
15.0000
18.5000
24.0000
29.0000
32.5000

0.0000
34.6520
34.6323
34.5899
34.5812
34.5717
34.5669
34.5646

0.00000
2.96326
3.26906
4.24677
4.59053
5.14625
5.66605
6.03704

2523.01
5048.12
5239.42
5808.17
5995.06
6285.15
6544.54
6723.36

0.0000
2.9632
3.2691
4.2468
4.5905
5.1462
5.6660
6.0371

0.00000
-0.00001
0.00001
0.00001
-0.00000
-0.00001
-0.00000
0.00001

Date, Slope Correction

POST CRUISE

CALIBRATION



-0.50

-0.25

0

0.25

0.50

0 50 100 150 200 250 300 350 400 450 500 550

R
es

id
ua

l (
%

 F
S

R
)

Pressure (PSIA)

13-Jan-16     0.00

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

y = thermistor output (counts)

t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2
 

x = instrument output - PTCA0 - PTCA1 * t - PTCA2 * t
2
 

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (PSIA) = PA0 + PA1 * n + PA2 * n
2
 

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6918
CALIBRATION DATE: 13-Jan-16

SBE 19plus V2 PRESSURE CALIBRATION DATA
508 psia S/N 3313900

COEFFICIENTS:
PA0 =
PA1 =
PA2 =
PTEMPA0 =
PTEMPA1 =
PTEMPA2 =

7.710222e-002
1.547684e-003
7.017601e-012
-5.538239e+001
 5.427974e+001
-2.598829e-001

PTCA0 =
PTCA1 =
PTCA2 =
PTCB0 =
PTCB1 =
PTCB2 =

 5.245112e+005
 4.210420e+000
-1.040188e-001
 2.490900e+001
-1.400000e-003
 0.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE
(PSIA)

INSTRUMENT
OUTPUT (counts)

THERMISTOR
OUTPUT (volts)

COMPUTED
PRESSURE (PSIA)

RESIDUAL
(%FSR)

14.50
104.77
204.78
304.78
404.78
504.79
404.79
304.79
204.79
104.79
14.51

533864.0
592086.0
656554.0
720997.0
785406.0
849770.0
785427.0
721032.0
656582.0
592120.0
533867.0

1.4
1.4
1.4
1.4
1.4
1.4
1.4
1.4
1.4
1.4
1.4

14.51
104.76
204.75
304.76
404.78
504.78
404.81
304.81
204.79
104.81
14.51

0.00
-0.00
-0.01
-0.00
-0.00
-0.00
0.00
0.00
0.00
0.00
0.00

TEMP
(°C)

THERMISTOR
OUTPUT (volts)

INSTRUMENT
OUTPUT (counts)

32.50
29.00
24.00
18.50
15.00
4.50
1.00

1.63
1.57
1.47
1.37
1.30
1.11
1.04

534094.54
534103.05
534110.55
534110.58
534106.91
534084.83
534072.70

TEMPERATURE (°C) SPAN (mV)
-5.00
35.00

24.92
24.86

Date, Offset (%FSR)
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n = Instrument Output (counts)

MV = (n - 524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 (°C) = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15

Residual (°C) = instrument temperature - bath temperature

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 6918
CALIBRATION DATE: 16-Jan-16

SBE 19plus V2 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  1.290840e-003
a1 =  2.693568e-004
a2 = -9.878554e-007
a3 =  1.738923e-007

BATH TEMP
(° C)

INSTRUMENT
OUTPUT (counts)

INST TEMP
(° C)

RESIDUAL
(° C)

     1.0000
     4.4999
    15.0000
    18.5000
    24.0000
    29.0000
    32.5000

   563963.644
   497041.780
   333872.034
   290815.186
   232913.610
   189289.966
   163143.678

     0.9999
     4.5000
    14.9999
    18.4999
    24.0000
    29.0001
    32.4999

   -0.0001
    0.0001
   -0.0001
   -0.0001
    0.0000
    0.0001
   -0.0001

Date, Offset (mdeg C)

POST CRUISE

CALIBRATION



Customer: Atlantic Marine Center

Job Number: 86435N

Model Number SBE 19Plus

Date of Report: 1/18/2016

Serial Number: 19P65591-6918

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/16/2016 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00088 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 83595

Model Number SBE 45

Date of Report: 4/2/2015

Serial Number: 4553332-0276

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 3/25/2015 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00660 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 4/2/2015 Drift sinceDrift sinceDrift sinceDrift since +0.00160 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

19 Mar 1419 Mar 1419 Mar 1419 Mar 14
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f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductiv ity = (g + h * f
2
+ i * f

3
 + j * f

4
) / (1 +δ * t + ε * p) Siemens / meter

t = temperatur e[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 02-Apr-15

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.000781e+000
h =  1.569345e-001
i = -2.371795e-004
j =  4.448887e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006
WBOTC =  4.2855e-007

BATH TEMP
(ITS-90)

BATH SAL
(PSU)

BATH COND
(Siemens/m)

INST FREQ
(Hz)

INST COND
(Siemens/m)

RESIDUAL
(Siemens/m)

22.0000
1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

0.0000
34.6697
34.6499
34.6072
34.5981
34.5881
34.5829
34.5803

0.00000
2.96463
3.27057
4.24867
4.59253
5.14842
5.66838
6.03947

2527.81
5027.82
5217.49
5781.55
5966.93
6254.71
6512.06
6689.49

0.00000
2.96463
3.27056
4.24866
4.59253
5.14843
5.66838
6.03947

0.00000
0.00001
-0.00000
-0.00001
0.00000
0.00001
0.00000
-0.00000

Date, Slope Correction

CALIBRATION AFTER

CLEANING AND


REPLATINIZING CELL
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f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductiv ity = (g + h * f
2
+ i * f

3
 + j * f

4
) / (1 +δ * t + ε * p) Siemens / meter

t = temperatur e[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 25-Mar-15

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.009654e+000
h =  1.597590e-001
i = -1.025941e-003
j =  1.153514e-004

CPcor = -9.5700e-008
CTcor =  3.2500e-006
WBOTC =  4.2855e-007

BATH TEMP
(ITS-90)

BATH SAL
(PSU)

BATH COND
(Siemens/m)

INST FREQ
(Hz)

INST COND
(Siemens/m)

RESIDUAL
(Siemens/m)

22.0000
1.0000
4.5000
15.0000
18.5000
23.9999
29.0000
32.5000

0.0000
34.7572
34.7372
34.6945
34.6851
34.6747
34.6686
34.6643

0.00000
2.97139
3.27800
4.25825
4.60284
5.15988
5.68084
6.05248

2528.66
5027.34
5216.82
5780.06
5965.01
6251.92
6508.16
6684.37

0.00000
2.97144
3.27795
4.25821
4.60284
5.15996
5.68080
6.05184

0.00000
0.00005
-0.00004
-0.00004
-0.00000
0.00008
-0.00004
-0.00064

Date, Slope Correction

POST CRUISE

CALIBRATION
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Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln2(n)] + a3[ln3(n)]} - 273.15 (°C)
Residual = instrument temperature - bath temperature
n = instrument output

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 02-Apr-15

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  5.804378e-005
a1 =  2.697794e-004
a2 = -2.132790e-006
a3 =  1.422788e-007

BATH TEMP
(ITS-90)

INSTRUMENT
OUTPUT

INST TEMP
(ITS-90)

RESIDUAL
(ITS-90)

1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

695531.4
593246.7
375471.7
324402.1
259368.8
212934.6
186093.8

1.0000
4.5000
15.0000
18.5000
23.9999
29.0000
32.5000

0.0000
-0.0000
-0.0000
0.0001
-0.0001
0.0000
-0.0000

Date, Slope Correction
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Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln2(n)] + a3[ln3(n)]} - 273.15 (°C)
Residual = instrument temperature - bath temperature
n = instrument output

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 25-Mar-15

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  1.670173e-005
a1 =  2.793181e-004
a2 = -2.866220e-006
a3 =  1.610718e-007

BATH TEMP
(ITS-90)

INSTRUMENT
OUTPUT

INST TEMP
(ITS-90)

RESIDUAL
(ITS-90)

1.0000
4.5000
15.0000
18.5000
23.9999
29.0000
32.5000

695533.7
593248.4
375472.6
324403.0
259371.7
212939.7
186101.7

1.0000
4.5000
15.0000
18.5000
23.9999
29.0001
32.5000

-0.0000
0.0000
-0.0000
-0.0000
-0.0000
0.0001
-0.0000

Date, Slope Correction

POST CRUISE

CALIBRATION



Customer: Atlantic Marine Center

Job Number: 83595

Model Number SBE 45

Date of Report: 4/2/2015

Serial Number: 4553332-0276

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 3/25/2015 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00061 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'FINAL CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 4/2/2015 Drift sinceDrift sinceDrift sinceDrift since -0.00028 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

19 Mar 1419 Mar 1419 Mar 1419 Mar 14

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 83595

Model Number SBE 45

Date of Report: 4/2/2015

Serial Number: 4553332-0277

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 3/25/2015 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00340 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 4/2/2015 Drift sinceDrift sinceDrift sinceDrift since +0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

08 Mar 1408 Mar 1408 Mar 1408 Mar 14
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f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductiv ity = (g + h * f
2
+ i * f

3
 + j * f

4
) / (1 +δ * t + ε * p) Siemens / meter

t = temperatur e[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 02-Apr-15

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -9.767505e-001
h =  1.532256e-001
i = -2.543499e-004
j =  4.442261e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006
WBOTC =  4.2855e-007

BATH TEMP
(ITS-90)

BATH SAL
(PSU)

BATH COND
(Siemens/m)

INST FREQ
(Hz)

INST COND
(Siemens/m)

RESIDUAL
(Siemens/m)

22.0000
1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

0.0000
34.6697
34.6499
34.6072
34.5981
34.5881
34.5829
34.5803

0.00000
2.96463
3.27057
4.24867
4.59253
5.14842
5.66838
6.03947

2527.75
5074.20
5266.78
5839.29
6027.38
6319.31
6580.32
6760.30

0.00000
2.96463
3.27056
4.24866
4.59253
5.14843
5.66837
6.03957

0.00000
0.00001
-0.00001
-0.00000
0.00000
0.00001
-0.00000
0.00010

Date, Slope Correction

CALIBRATION AFTER

CLEANING AND


REPLATINIZING CELL
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f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductiv ity = (g + h * f
2
+ i * f

3
 + j * f

4
) / (1 +δ * t + ε * p) Siemens / meter

t = temperatur e[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 25-Mar-15

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -9.794501e-001
h =  1.538290e-001
i = -3.630906e-004
j =  5.289356e-005

CPcor = -9.5700e-008
CTcor =  3.2500e-006
WBOTC =  4.2855e-007

BATH TEMP
(ITS-90)

BATH SAL
(PSU)

BATH COND
(Siemens/m)

INST FREQ
(Hz)

INST COND
(Siemens/m)

RESIDUAL
(Siemens/m)

22.0000
1.0000
4.5000
15.0000
18.5000
23.9999
29.0000
32.5000

0.0000
34.7572
34.7372
34.6945
34.6851
34.6747
34.6686
34.6643

0.00000
2.97139
3.27800
4.25825
4.60284
5.15988
5.68084
6.05248

2528.08
5075.81
5268.50
5841.23
6029.38
6321.35
6582.35
6762.20

0.00000
2.97139
3.27801
4.25823
4.60285
5.15988
5.68084
6.05253

0.00000
-0.00001
0.00001
-0.00002
0.00001
0.00001
-0.00000
0.00006

Date, Slope Correction

POST CRUISE

CALIBRATION
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Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln2(n)] + a3[ln3(n)]} - 273.15 (°C)
Residual = instrument temperature - bath temperature
n = instrument output

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 02-Apr-15

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  8.931750e-005
a1 =  2.676627e-004
a2 = -1.972607e-006
a3 =  1.393936e-007

BATH TEMP
(ITS-90)

INSTRUMENT
OUTPUT

INST TEMP
(ITS-90)

RESIDUAL
(ITS-90)

1.0000
4.5000
15.0000
18.4999
24.0000
29.0000
32.5000

638596.3
544690.2
344735.8
297846.3
238133.4
195499.7
170852.3

1.0001
4.4999
15.0001
18.5000
24.0000
28.9999
32.5001

0.0001
-0.0001
0.0001
0.0001
-0.0000
-0.0001
0.0001

Date, Slope Correction
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Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln2(n)] + a3[ln3(n)]} - 273.15 (°C)
Residual = instrument temperature - bath temperature
n = instrument output

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 25-Mar-15

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
a0 =  1.717778e-005
a1 =  2.845634e-004
a2 = -3.291842e-006
a3 =  1.737056e-007

BATH TEMP
(ITS-90)

INSTRUMENT
OUTPUT

INST TEMP
(ITS-90)

RESIDUAL
(ITS-90)

1.0000
4.5000
15.0000
18.5000
23.9999
29.0000
32.5000

638588.2
544679.5
344732.9
297841.7
238131.4
195498.1
170857.9

0.9999
4.5001
14.9999
18.5000
23.9999
29.0002
32.4999

-0.0001
0.0001
-0.0001
-0.0000
-0.0000
0.0002
-0.0001

Date, Slope Correction

POST CRUISE

CALIBRATION



Customer: Atlantic Marine Center

Job Number: 83595

Model Number SBE 45

Date of Report: 4/2/2015

Serial Number: 4553332-0277

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 3/25/2015 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00040 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'FINAL CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 4/2/2015 Drift sinceDrift sinceDrift sinceDrift since -0.00050 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

08 Mar 1408 Mar 1408 Mar 1408 Mar 14

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report
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